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Capitulo 1: Introduccién

Capitulo 1: Introduccion

Harmony es un software de animacién completo que permite crear todo tipo de proyectos de animacién
creativos. Incluye distintas herramientas y funciones.

En esta Guia de introduccidn, aprenderd las principales funciones y los conceptos basicos de Harmony
Essentials, que le permitirdn ponerse al dfa rdpidamente. Consulte la documentacidon completa de Toon Boom
Harmony disponible en linea en docs.toonboom.com para aprender acerca de todas las herramientasy

opciones, asi como sobre las técnicas avanzadas.


http://docs.toonboom.com/
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Capitulo 2: Acerca de la pantalla de bienvenida

Capitulo 2: Acerca de la pantalla de bienvenida

Al iniciar Toon Boom Harmony, aparece la pantalla de bienvenida. Si ya hay una escena abierta, puede mostrar
la pantalla de bienvenida seleccionando Help > Show Welcome Screen (Ayuda > Mostrar pantalla de

bienvenida).

La pantalla de bienvenida permite:

1.

2.

3.

Crear escenas

Seleccionar la resolucién de la escena

Administrar los valores predeterminados de la resolucién de la escena
Abrir répidamente escenas abiertas recientemente

Examinar y abrir una escena de sus documentos

Ver tutoriales en video de Harmony

Abrir la pdgina de soporte en linea
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Capitulo 3: Creacién de una escena

Capitulo 3: Creacion de una escena

Puede crear o abrir una escena utilizando la pantalla de bienvenida.

Creacion de una escena desde la pantalla de bienvenida

1. En el campo Name (Nombre), escriba el nombre de la escena.

NOTA

El nombre de la escena no debe superar los 23 caracteres y no puede contener
caracteres especiales, como *&A%!.

2. Paradecidir en qué directorio se va a crear la escena, haga clic en el botén Browse (Examinar) junto
al campo Location (Ubicacién).

NewScene

NewScene

4. Haga clicen Create Scene (Crear escena).

Se crea una nueva escena.

10
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Capitulo 4: Introduccidn a la interfaz de usuario de Harmony

Capitulo 4: Introduccidn a la interfaz de usuario de
Harmony

El uso de Toon Boom Harmony serd mucho mds facil si primero se familiariza con su interfaz de usuario. En este
capitulo se proporciona una introduccién bdsica a los elementos mas importantes de la interfaz de usuario. A
medida que avance por los capitulos, aprenderd informacién mds detallada sobre cada uno de estos elementos.

Al iniciar Toon Boom Harmony por primera vez, se presenta el espacio de trabajo predeterminado. El espacio de
trabajo estd compuesto de barras de herramientas y paneles, denominados vistas, que permiten crear y editar
la escena. El espacio de trabajo predeterminado contiene las barras de herramientas y vistas mas utilizadas

para la animacién digital.

Ment
Vista de
—propiedades de
h Ba.”:tg: la herramienta
erramie
Tools]|
(Herramientas)
— Vista de color
Vista de
camara
Barra de
herramientas
Playback
(Repreducir) |_Vista de linea
de tiempo

Adicion de una vista al espacio de trabajo como una pestana

1. Enlaesquina superior derecha de una vista existente, haga clic en el botén Add View (Agregar
vista) + .

12
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Camera

2. Seleccione la vista que desee en la lista.

La vista aparece como una nueva pestafia en la misma seccién del espacio de trabajo:

Function = 4=|%

@ NOTA

Algunas vistas, como la de cdmara, se pueden abrir en varias instancias. Por ejemplo, puede
resultar Util si desea tener dos instancias de las vistas de cdmara abiertas, cada una centrada
en distintas dreas de la escena, para cambiar rdpidamente entre los trabajos de estas dos
dreas.

Adicién de una vista al espacio de trabajo como una ventana

1. Abrael menld Windows (Ventanas).

2. Seleccione la vista que desee agregar.

13
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La vista aparecera como una nueva ventana sobre la ventana de la aplicacién principal de Harmony.

Anclaje de una ventana de vista en el espacio de trabajo

1. Arrastre la ventana por su pestanay realice una de las siguientes acciones:

« Cologue la ventana sobre otras pestanas existentes para agregarla al conjunto de
pestanas.

o Coloque la ventana por encima, por debajo o junto a una vista existente. Al acercarse al
borde de una vista, aparece un rectangulo negro con fondo azul, que indica dénde se
insertard la vista.

Vistas

Aqui se proporciona una breve introduccién a cada una de las vistas mas utilizadas en Harmony.

Vista de camara

La vista de cdmara es el centro de operaciones en Harmony. En esta vista puede dibujar, pintar, animar,
configurar la escena, manipular objetos, abrir simbolos y previsualizar la animacién.

La vista de cdmara también tiene una barra de herramientas superior e inferior que puede utilizar para navegar
en la vista, cambiar el modo de visualizacién o subir la jerarquia de simbolos.

14
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Jerarquia de simbolos

herramient
as Camera
(Cémara)
Miodo de vista de OpenGL
Mesa de luz MNombre del dibujo Nombre de i Ny Color
Dibujo actual encima| Restablecer vista Modo de vista de render

Vista de dibujo

En Harmony, puede dibujar tanto en la vista de dibujo como en la de cdmara. Aunque las dos vistas son
similares, hay algunas diferencias cuando se trata de dibujar.

En la vista de dibujo solo se muestra el dibujo seleccionado de forma predeterminada. Puede utilizar funciones
como la mesa de luz para mostrar el dibujo actual de todas las capas habilitadas de la escena con colores
lavados, o el papel cebolla para mostrar los dibujos anteriores y siguientes de la capa de dibujo seleccionada
actualmente.

15
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Barra de herramientas Drawing view (Vista de dibujo)

Camera = Drawing

Area de
dibujo

Nombre del dibujo MNombre de herramienta MNimerode  Posicion Selector de color
fotograma  del cursor

Vista de propiedades de la herramienta

La vista de propiedades de la herramienta contiene las opciones y operaciones mds comunes relacionadas con
la herramienta seleccionada actualmente. Al seleccionar una herramienta en la barra de herramientas Tools
(Herramientas), se actualiza la vista de propiedades de la herramienta.

Por ejemplo, si elige la herramienta Select (Seleccionar), la vista de propiedades de la herramienta mostrar4 las
opciones y operaciones relacionadas con dicha herramienta, como Snap to Contour (Ajustar a contorno), Apply
to All Drawings (Aplicar a todos los dibujos), Flip Horizontal (Voltear en horizontal) y Flatten (Acoplar).

Posibles opciones y modos
para la herramienta actual

Posibles operacicnes par la
herramienta actual

16
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Vista de color

La vista de color es donde se crean colores y paletas y se importan paletas existentes en el proyecto. La vista de
color también es necesaria para dibujar, pintar y crear estilos de color.

Bajar/subir paleta
Importar paleta

Quitar paleta

Meni de color Agregar paleta
Zolour + %
Contraer/expandi
lista de paletas
Scene Palettes

pun | ista de paletas

[ Al

Agregar muestra de color
Quitar muestra de calor
Agregar textura

Lista de muestras
de colores

|
 —
—
—
—1
—1
L
—
—1
 —
—
L
=
 —
H—

Muestra de color
Nombre del colol

Vista de linea de tiempo

Para establecer el tiempo de la animacidn, trabajara principalmente con las vistas de linea de tiempo y de carta
de rodaje. Es muy dtil familiarizarse con la vista de linea de tiempo, su funcionamiento y su interfaz.

La vista de linea de tiempo es la vista principal utilizada al ajustar el tiempo de los dibujos, agregar fotogramas
clave y ordenar capas. La vista de linea de tiempo muestra capas, efectos, sonidos, valores de fotogramas clave,
longitud de escena, nombres de capas, dibujos, fotogramas clave, tiempo y fotogramas.

17
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Habilitar/deshabilitar capa
Habilitar/deshabilitar modo Solo Agregar capa
Agregar/quitar papel cebolla Eliminar capa
Bloquear/desbloquear capa Agregar capa de dibujo
Alternar modo esbozo Agregar peg

Maostrarjocultar
ima&genes miniatura

Parametros Cursor de fotograma actual  Exposicién de dibujo Dividir vista
1

AR FARA EoA

Expandir/contraer grupo

Mostrarjocultar Valores de Zoom de linea de tiempo Fotograma clave

Expandir/contraer
g ! s funciones fotograma clave

Mostrar/ocultar vinculos adicionales L
) Sustitucion de
Mastrarfocultar parametros dibujo

La vista de linea de tiempo permite leer el tiempo de izquierda a derecha. Representa los elementos de la
escena en su forma mds simple. También puede ver las capas y sus nombres, asi como la exposicién del dibujo. El
nombre del dibujo se muestra al colocar el puntero sobre la exposicién del dibujo.

Vista de carta de rodaje

La vista de carta de rodaje permite leer el tiempo verticalmente mostréndolo en una cuadricula, con cada capa
de dibujo representada por una columna, cada fotograma de la escena representado por una fila y cada dibujo
expuesto mostrado por sunombre en las celdas. Se pretende que funcione como una carta de exposicion de
animacién tradicional.

Con el panel de funciones, también puede ver las funciones y los fotogramas clave de las rutas de movimiento
de la columna seleccionada, con el valor de esas funciones para cada fotograma que se muestra en las celdas.

A diferencia de la vista de linea de tiempo, la vista de carta de rodaje no muestra pegs, efectos o jerarquia de
capas. Por lo tanto, se optimiza para una animacién tradicional y sin papel, mientras que la vista de linea de
tiempo se optimiza para una animacién digital o Cut-out.

18
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Barra de herramientas
¥sheet(Carta de rodaje)

Encabezado de columna

Dibujo actual

Fotograma actual

Exposicidn de dibujo

Panel >
principal

Nimeros de fotograma Dibujolelemenic Columna de Aumentarfredudr Modo Overwriteflnsert
actual funcién <posicid (Sob ibirfinsertar)

Vista de libreria

La vista de libreria se utiliza para almacenar elementos como animaciones, dibujos, fondos y modelos de
personajes para volver a utilizarlos en distintas escenas y proyectos. También puede utilizar |la vista de libreria
para crear y almacenar simbolos, asi como para almacenar e importar imagenes y archivos de sonido.

Para reutilizar elementos de una escena en otras escenas, debe crear una plantilla para poder importarla en
distintas escenas. Las plantillas pueden contener cualquier elemento, desde un solo dibujo hasta una estructura
de escena completa. Puede crear una plantilla en una escena y copiar los elementos que desee tener en la
plantilla en una libreria. La plantilla resultante se estructura como una miniescena que solo contiene los
elementos que copid en ella. Una plantilla no tiene ninguna dependencia en la escena en la que se creé
originalmente. Por lo tanto, se puede importar de forma segura en cualquier otra escena.

Ademas, el panel Drawing Substitution (Sustitucidn de dibujo) de la vista de libreria permite cambiar
rapidamente la exposicion del fotograma actual a uno de los dibujos existentes en una capa. Esto es
especialmente Util para la animacién de las bocas, manos, parpados y otras partes del cuerpo de un personaje
Cut-out que suelen contener varios dibujos donde elegir.

19
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Lista de recursos

Vista previa de
imagen miniatura

Mombre del dibujo !

Nombre del elementofrecurso

<
>

Confrol deslizante de

fotogramaldibuio
[ATTS]

Barra de bisqueda

Lista de carpetas
de libreria

1. El campo del nombre del dibujo solo aparece si se selecciona un elemento de la escena.

Interfaz de navegacion

Toon Boom Harmony permite acercar, alejar, rotar, panear y restablecer vistas para navegar facilmente por la
interfaz.

Los comandos de navegacion de la tabla que se muestra a continuacidn se pueden utilizar en las siguientes
vistas, con algunas excepciones:

o Cdmara

o Dibujo

e Lineadetiempo
« Cartaderodaje
« Funcién

o Lateral y superior

Comando Accién Métodos de acceso

View > Zoom In (Ver > Acercar)

Pulse 2

Zoom In .

Acerca la vista. . c . .

(Acercar) Gire la rueda del ratén hacia arriba
(excepto en las vistas de linea de
tiempo y de carta de rodaje).
View > Zoom Out (Ver > Alejar)
Pulse 1

Zoom Out . .

. Aleja la vista. . , . .
(Alejar) Gire la rueda del ratén hacia abajo

(excepto en las vistas de linea de
tiempo y de carta de rodaje).

20
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Zoom In or Out
(Acercar o alejar)

Acerca o aleja la vista.

Gire la rueda central del ratén hacia
arriba o hacia abajo.

Mantenga pulsada la barra espaciadora
y la rueda central del ratén mientras
arrastra el ratén hacia arriba o hacia
abajo.

Pan (Panear)

Mueve la vista horizontal o verticalmente.

Mantenga pulsada la barra espaciadora
y arrastre en la direccién que desee
panear la vista.

Reset Pan
(Restablecer
paneo)

Restablece el paneo de vista a su posicion predeterminada.

View > Reset Pan (Ver > Restablecer
paneo)

Pulse Mayus + N

Reset View
(Restablecer
vista)

Restablece la vista a su posicién predeterminada.

View > Reset View (Ver > Restablecer
vista)

Pulse Maylis + M

Reset Rotation
(Restablecer
rotacién)

Restablece la rotacién de vista a su posicién
predeterminada.

View > Reset Rotation (Ver >
Restablecer rotacién)

Pulse Mayus + X

Reset Zoom
(Restablecer
zoom)

Restablece el zoom de vista a su posicién predeterminada.

View > Reset Zoom (Ver > Restablecer

zoom)

Rotate View

(Rotar vista)

Rota la vista.

Pulse Ctrl+Alt (Windows/Linux) o
Ctrl+38 (macQS) y arrastre en la
direccidén que desee rotar la vista.

(Alternar primer
plano répido)

encuentra al 100 %, esto hard que alterne entre 400 %y
100 %.

Rotate 30 CW . 3 N .

(Rotar 30 Rota la vista de cdmara 30 grados a la derecha, como una View > Rotate View CW (Ver > Rotar
otar

mesa de animacidon. vista a la derecha)

derecha)

Rotate 30 CCW . ; . . . .

(Rotar 30 Rota la vista de cdmara 30 grados a laizquierda, como una | View > Rotate View CCW (Ver > Rotar
otar

. . mesa de animacién. vista a la izquierda)

izquierda)

Toggle Quick Multiplica al instante el factor de zoom de la vista por 4. Por

Close-up ejemplo, si el factor de zoom de la vista de camara se

Mayls+Z

Toggle Full
Screen (Alternar
pantalla
completa)

Pasa por los siguientes modos de visualizacién:

o Normal Full-Screen (Pantalla completa normal): La
ventana principal de la aplicacién se convierte en
pantalla completa.

o View Full-Screen (Ver pantalla completa): La vista
seleccionada se convierte en pantalla completa y
todas las demds vistas se contraen.

View > Toggle Full Screen (Ver >
Alternar pantalla completa)

Pulse Ctrl + F (Windows/Linux) o &8 +
F (macQS)

21
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« Normal: La ventana principal de la aplicaciéon se
restaura a su tamafio original y las vistas contraidas
se expanden.

Interfaz tactil

Si estd trabajando con una pantalla tactil, un trackpad o una tableta que admita funcidn tactil, también puede
utilizar los gestos de dos dedos estdndar para zoom, rotacién y paneo en las vistas de cdmara y dibujo. Para
poder hacer esto, primero debe habilitar la preferencia Support Gestures (Soporte de gestos).

Habilitacién del soporte de gestos

1. En el menu superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows/Linux) o Harmony
> Preferences (Harmony > Preferencias) (Mac OS X).

2. Abrala pestafa General.

3. Enlaseccidén Touch Interface (Interfaz tdctil), active la casilla de verificacién Support Gestures

(Soporte de gestos).
4. Hagaclicen OK (Aceptar).
5. Reinicie Harmony.

Ahora puede manipular las vistas de cdmara y de dibujo arrastrando dos dedos sobre la interfaz
tactil.

Uso de gestos

1. En lavista de cdmara o de dibujo, presione con dos dedos situados a una distancia corta entre si.
2. Realice una de las siguientes acciones:

o Parapanear la vista, arrastre los dos dedos en cualquier direccién, manteniéndolos a la
misma distancia uno del otro.

22
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o Paraacercar el zoom, arrastre los dos dedos separando uno del otro.

o Paraalejar el zoom, arrastre los dos dedos acercando uno al otro.

o Pararotar, arrastre los dos dedos haciendo una curva para que giren en la misma
direccién.

23
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Capitulo 5: Cémo dibujar

Una vez iniciado Toon Boom Harmony, puede comenzar a dibujar inmediatamente utilizando la capa de dibujo
predeterminada.

Cémo dibujar

1. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel) &~ o
pulse Alt + B.

2. Enlavista delinea de tiempo o de carta de rodaje, haga clic en la primera celda de la capa de dibujo.

3. Para seleccionar un color, haga clic en el color que desee utilizar en la vista de color. Para obtener
mads informacion sobre la creacidn y edicién de colores, consulte Creacidn o edicién de muestras de

colores en la pdgina 30.

Colour  ==[%
+ — = ¥
Scene Palettes

[Adlw ]

4. En lavista de dibujo o de cdmara, comience a dibujar.

24
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Ajuste de dibujos

Harmony ofrece distintas maneras de ajustar los dibujos. Puede deshacer la dltima linea vectorial transparente,
borrar partes de un dibujo, mover, transformar o eliminar lineas vectoriales transparentes, y modificar los
puntos vy las curvas de las lineas de lapiz.

Cdémo deshacer la ultima linea vectorial transparente

1. Realice una de las siguientes acciones:
« En el menu superior, seleccione Edit > Undo (Editar > Deshacer).

o Pulse Ctrl + Z (Windows/Linux) o 3£ + Z (macQOS).

Cémo borrar

1. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Eraser (Borrador) & o
pulse Alt + E.

2. Enlavista de dibujo o de cdmara, dibuje una linea vectorial transparente sobre las partes del dibujo
que desee borrar.

Edicidn de las lineas vectoriales transparentes del dibujo

1. Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Select (Seleccionar) %
o pulse Alt + S.

2. En lavista de cdmara, seleccione las lineas vectoriales transparentes que desee editar realizando
una de las siguientes acciones:

25



Capitulo 5: Cémo dibujar

« Haga clicen una linea vectorial transparente para seleccionarla.

« Mantenga pulsada la tecla Mayus mientras hace clic en una linea vectorial
transparente para agregarla a la seleccidn.

« Dibuje un lazo alrededor de las lineas vectoriales transparentes del dibujo para
seleccionarlas simultdneamente.

3. Realice una de las siguientes acciones para editar la seleccidn:

« Para cambiar la posicién, haga clic en el objeto de dibujo seleccionado y arrastre la
seleccién a una nueva area.

NOTA

También puede realizar un desplazamiento pequefio de la seleccién con
las teclas de flecha y, para realizar un desplazamiento rdpido, mantenga
pulsada la tecla Mayus y pulse las teclas de flecha.

« Pararotar, agarre el controlador de la caja de seleccién y rételo.

26



Guia de introduccién de Toon Boom Harmony 15 Essentials

o Paraescalar, tire o empuje en el punto de control superior, lateral, inferior o de esquina.
Mantenga pulsada la tecla Mayus para bloquear la proporcidon de la seleccién.

« Parasesgar, arrastre hacia los lados o arriba y abajo los lados o los segmentos superior
e inferior, entre los puntos de control.

o Paraeliminar, pulse Supr (Windows/Linux) o retroceso (macQS).
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Capitulo 6: Como pintar

Toon Boom Harmony incluye algunas funciones de pintura muy Utiles para agregar color a los dibujos. Mientras
que otro software solo permite que los usuarios trabajen con muestras de color de una en una, la pintura en
Harmony se realiza con paletas que contienen varias muestras de color que se pueden almacenar y reutilizar
segln sea necesario.

HUROROEANO00

En la vista de color, seleccione una muestra de color distinta para cada color que desee pintar en el dibujo.
Puede agregar todas las muestras de color que desee. También puede cambiar el nombre a las existentes y
modificarlas.

INOOAO00NN
I0CRR0OgENC

Cuando modifique el color de una muestra existente, se actualizardn automaticamente todas las zonas pintadas
con esta muestra en toda la escena. La muestra de color tiene un ndmero de ID exclusivo que la asocia con las
zonas pintadas. De este modo, puede cambiar el aspecto del personaje en cualguier momento sin necesidad de
volver a pintarlo.

28



Guia de introduccién de Toon Boom Harmony 15 Essentials

Otra ventaja de este sistema es que puede crear paletas completas para distintas situaciones de luz. Por
ejemplo, ademds de la paleta habitual para un personaje, también puede tener una para ese personaje en la
lluvia con colores mds apagados y menos vivos que los colores de dfas secos, o incluso otra para una escena de
noche. De este modo, el uso de paletas vinculadas a un personaje permite cambiar el color al instante para
ajustarse al clima y al ambiente de la escena sin necesidad de volver a pintar cada elemento.

Paletas de colores

En animacidn se utilizan colores especificos para pintar cada parte de cada personaje. Con el fin de mantener
una coherencia absoluta, se debe crear una paleta de colores base para cada personaje, prop y efecto de la
produccidn. A esto se le denomina paleta maestra.

Las paletas maestras contienen una muestra de color para cada drea que se deba colorear. Cada muestra
almacena un color de niveles precisos de rojo, verde, azul y opacidad (a este Ultimo se le denomina alfa).

El uso de una paleta de colores maestra tiene muchas ventajas, entre otras:
« Cada personaje conserva permanentemente sus colores especificos.
« No puede usar por error un color que no esté en la paleta maestra.
« Estandarizacion y uniformidad del color durante la produccidn.
o Varios artistas pueden usar la misma paleta de colores y generar los mismos resultados.

Harmony utiliza paletas para mantener todos los colores necesarios para pintar los elementos, lo que permite un
control y uniformidad totales del proceso de pintado.

Una paleta se crea asignando un conjunto de colores a cada personaje, prop o efecto. Creard una nueva paletay
agregarda un nuevo color, conocido como muestra de color, para cada zona del personaje, como la piel, el pelo, la
lengua, la camiseta, los pantalones, etc.

Creacion de una nueva paleta

1. En el menu de vista de color, seleccione Palettes > New (Paletas > Nueva) o haga clic en el botén
New Palette (Nueva paleta)

Se abre el cuadro de didlogo Create Palette (Crear paleta).

2. Introduzca el nombre de la paleta seguin el modelo.

oK Cancel

3. Hagaclicen OK (Aceptar).

La paleta aparece en la lista de paletas.
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Colour =%

Scene

[Adlw ]

Creacidn o edicion de muestras de colores

1. Sidesea crear una nueva muestra de color, haga clic en el botén Add Colour (Agregar color) enla
vista de color. Si desea editar una muestra de color existente, seleccione el color en la vista de color.

2. Realice una de las siguientes acciones para editar la muestra de color:
« En el menu de vista de color, seleccione Colours > Edit (Colores > Editar).
o Haga doble clic en la muestra de color.

Se abre la ventana Coulour Picker (Selector de color).

Multi Wheel Mode

3. Paradefinir el color, realice una de las siguientes acciones:

« Seleccione Red (Rojo), Green (Verde), Blue (Azul), Hue (Matiz), Saturation (Saturacién)
o Value (Valor) para cambiar el espectro del circulo cromatico y, a continuacién, haga
clic en el color que desee en el circulo cromatico.

« Introduzca los valores de matiz, saturacion, valor, rojo, verde y azul de forma manual en
los campos correspondientes. Todos los valores oscilan entre O y 255.
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NOTA

Si cambia una muestra de color después de haber dibujado o pintado con él dreas de un dibujo,
todas las dreas pintadas con este color en los dibujos se actualizardn al nuevo color.

Pintado

Puede pintar las zonas cerradas de los dibujos con la herramienta Paint (Pintar).

Cémo pintar dibujos

1. Enlavista de linea de tiempo o de carta de rodaje, seleccione el dibujo que desea pintar.

2. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Paint (Pintar) ® o
pulse Alt + .

3. Enlavista de color, seleccione la paleta del personaje.

4. Seleccione un color de la paleta.

Colour  ==[%

Scene Palettes

[Adlw ]

5. Enlavista de dibujo o de cdmara, comience a pintar el dibujo con los colores.
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NOTA

Al abrir una escena, las paletas de esta no se cargaran inmediatamente en la vista de color.
Primero debe seleccionar un dibujo.

Cierre de huecos

Al pintar, puede encontrar que algunas dreas del dibujo no estaban completamente cerradas debido a
pequefios huecos en los contornos, lo que impide que la herramienta Paint (Pintar) rellene el drea, ya que solo
rellena formas cerradas. Para cerrar la zona, puede dibujar una linea sobre el hueco con la herramienta Brush
(Pincel) o Pencil (Lapiz). Sin embargo, solo es posible cerrar el hueco agregando encima una linea invisible, que
la herramienta Paint (Pintar) considerara como una linea normal. En Harmony, las lineas invisibles utilizadas
para definir las dreas que se deben colorear se denominan lineas vectoriales transparentes.

La herramienta Close Gap (Cerrar hueco) permite cerrar pequenos huecos en el contorno de un dibujo
dibujando al instante una linea vectorial transparente para rellenar el hueco. A diferencia de la herramienta
Stroke (Linea vectorial transparente), con la herramienta Close Gap (Cerrar hueco) no tiene que dibujar con
precisién. Solo tiene que dibujar una linea vectorial transparente bdsica junto al hueco para que se cree
automaticamente una linea vectorial transparente recta que conecte directamente un extremo del hueco al otro.
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Uso de la herramienta Close Gap (Cerrar hueco)

1. Antesde trabajar con lineas vectoriales transparentes, se recomienda habilitar la opcién Show
Strokes (Mostrar |lineas vectoriales transparentes), de modo que pueda verlas en la vista de dibujo o
de cdmara. Puede habilitar la opcién Show Strokes (Mostrar lineas vectoriales transparentes)
realizando una de las siguientes acciones:

« En el menu superior, seleccione View > Show > Show Strokes (Ver > Mostrar >
Mostrar lineas vectoriales transparentes).

e Pulse K
2. Realice una de las siguientes acciones:

o Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Close Gap
(Cerrar hueco) (.

« En el menu superior, seleccione Drawing > Drawing Tools > Close Gap (Dibujo >
Herramientas de dibujo > Cerrar hueco).

e Pulse Alt + C.
3. Enlavista de cdmara o de dibujo, trace una linea invisible cerca del hueco que se va a cerrar.

El hueco se cierra automaticamente.

NOTA

La herramienta Paint (Pintar) también incluye una opcidén Close Gap (Cerrar hueco), que se puede
habilitar en la vista de propiedades de la herramienta. Cuando esté habilitada, Harmony
automaticamente intentard encontrar y cerrar pequefios huecos cuando intente rellenar una forma
que no esté cerrada.
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Capitulo 7: Creaciéon de una animacion tradicional sin
papel

Creacidon de un boceto de animacion

El primer paso para crear una animacion sin papel es la creacidén de un boceto, que es el esqueleto de la
animacién. Por lo general, empezarfa animando la parte mds importante de la accién de un personaje. Por
ejemplo, para animar un ciclo de andar, comenzara por el movimiento del torso y de las piernas. Después se
puede agregar una animacién secundaria como la cabeza, los brazos vy la ropa.

Para que la animacién sea satisfactoria, comience animando la accidén principal con esbozos bdsicos y rdpidos y,
a continuacion, agregue los detalles cuando esté satisfecho con el movimiento. Si comienza a animar todos los
detalles inmediatamente, perderd mucho tiempo en caso de tener que realizar correcciones, y es probable que

la animacidn parezca rigida.

Creacién de un boceto de animacion

1. En lavista de linea de tiempo, haga clic en Show All Thumbnails (Mostrar todas las imagenes
miniatura) m para habilitar el modo Thumbnail (Imagen miniatura).

2. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel) 4 o
pulse Alt + B.

3. Enlavista de color, seleccione un color para el pincel. Es una buena idea elegir un color claro para el
boceto de animacién. Esto facilitard el proceso de clean up, ya que las lineas oscuras y limpias
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contrastardn con las lineas esbozadas claras.

4. En lavistadelinea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca
el primer dibujo.

5. En lavista de cdmara o de dibujo, dibuje el primer dibujo clave.

En cuanto dibuje la primera linea vectorial transparente, se creard automdticamente un dibujo en la
celda seleccionada.

MroSalM

6. Aumente el nivel de zoom de la vista de linea de tiempo hasta que vea las imdgenes miniatura
dentro de las celdas realizando una de las siguientes acciones:

o Arrastre el control Timeline Zoom (Zoom de linea de tiempo) hacia la derecha.
« Haga clicen la pestafia de la vista de linea de tiempo y pulse 2 de forma reiterada.

o Mueva el cursor del ratén en la vista de linea de tiempo, mantenga pulsada la tecla Ctrl
(Windows/Linux) o & (macOS) y gire la rueda del ratén hacia arriba.
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CErL T
o

7. Enlavista delinea de tiempo o de carta de rodaje, seleccione la celda en la que desea que aparezca
el préximo dibujo clave.

8. Enlabarra de herramientas Tools (Herramientas), haga clic en el botén Onion Skin (Papel cebolla)
< . Esto mostrard los dibujos anteriores y siguientes en un color claro en la vista de cdmara o dibuijo,
detrds del dibujo actual, para que pueda utilizarlos como referencias para realizar nuevos dibujos con
precision. Esta opcidn puede ser Util para dibujar poses de descomposicidn entre dos poses clave, o
para agregar un dibujo intercalado entre otros dos dibujos.

9. Asegulrese de que el papel cebolla muestre el primer dibujo clave para que pueda basar el segundo
dibujo clave en él. Para llevarlo a cabo, realice una de las siguientes acciones:

« Enlavista de linea de tiempo, arrastre los marcadores azules de papel cebolla para
ampliar el nimero de dibujos anteriores y siguientes para que se visualicen como papel
cebolla.

o Enlabarrade herramientas Camera View (Vista de cdmara) o Drawing View (Vista de
dibujo), utilice los botones Onion Skin Add One Previous Drawing (Agregar un dibujo
anterior de papel cebolla) <, Onion Skin Reduce One Previous Drawing (Reducir un
dibujo anterior de papel cebolla) =, Onion Skin Reduce One Next Drawing (Reducir
un dibujo siguiente de papel cebolla) = y Onion Skin Add One Next Drawing
(Agregar un dibujo siguiente de papel cebolla) = para ajustar la extension del papel
cebolla fotograma a fotograma.

10. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

o Enlabarrade herramientas Timeline (Linea de tiempo) o Xsheet (Carta de rodaje),
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haga clicen el botén Create Empty Drawing (Crear dibujo vacio) .
« Pulse Alt + Mayus + R.

11. En lavista de cdmara o de dibujo, dibuje el segundo dibujo clave.

no=amE
[ P

13. Cree un nuevo dibujo vacio mediante una de las siguientes acciones:

« Enlabarrade herramientas Timeline (Linea de tiempo) o Xsheet (Carta de rodaje),
haga clic en el botdn Create Empty Drawing (Crear dibujo vacio) .

« Pulse Alt + Mayus + R.

14. En la vista de cdmara o de dibujo, dibuje la nueva pose.

15. En lavista de linea de tiempo o de carta de rodaje, seleccione una nueva celda y repita los pasos
anteriores para cada nuevo dibujo.
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NOTA

Al trabajar con capas de superposicidon en la vista de cdmara, puede habilitar la opcidn Current
Drawing on Top (Dibujo actual encima) £ para hacer que la capa en la que estd trabajando

aparezca sobre las otras capas.

Revision de la animacidén

Al realizar un flipping por los dibujos se puede ver si los dibujos en los que se estd trabajando conectan bien
entre si'y crean lailusién de movimiento adecuada. Puede desplazarse rdpidamente por los dibujos con los
atajos de teclado para ir al dibujo anterior e ir al dibujo siguiente.

Desplazamiento por los dibujos

1. En lavista de linea de tiempo o de carta de rodaje, seleccione el dibujo desde donde desee

desplazarse.
2. Realice una de las siguientes acciones:
e Pulse F parair al dibujo anterior.
o Pulse G parair al dibujo siguiente.

3. Pulse ambos atajos de forma reiterada con rapidez para desplazarse por los dibujos hacia atras o

hacia delante.

Cuando el boceto de animacidn esté terminado, reproduzcalo para asegurarse de es lo que se esperaba antes
de continuar con el siguiente paso.

Reproduccién de la animacion

1. Enlavista de linea de tiempo, utilice los botones Enable/Disable All (Activar/desactivar todo) @« y
Solo @ para desactivar todas las capas que no desee ver durante la reproduccion.

MroSalM

2. Enlavista delinea de tiempo, mueva el cabezal rojo al primer fotograma de la animacién y haga clic
en el botdn Start (Iniciar) en la barra de herramientas Timeline (Linea de tiempo). A continuacidn,
mueva el cabezal al dltimo fotograma de la animacién y haga clic en el botén Stop (Detener).
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3. Enlabarrade herramientas Playback (Reproducir), haga clic en el botén Loop (Bucle) © para

habilitar la opcién de bucle durante la reproduccién.

4. En labarrade herramientas Playback (Reproducir), haga clic en el botén Play (Reproducir) » para

comenzar con la reproduccion.

Limpieza

Una vez que se haya completado el boceto de animacidn, es el momento de limpiarlo y tintarlo. A este paso
también se le denomina trazado. Consiste en trazar lineas sélidas y limpias sobre el boceto de animacién para
cerrar las zonas abiertas. Es el paso final de la animacién sin papel antes del paso de ink and paint.

En una animacidn tradicional, los dibujos de clean up se suelen trazar en una nueva hoja de papel con el boceto
debajo, que se puede ver con la mesa de luz del disco de animacién. Del mismo modo, en Harmony, tendra que
agregar una nueva capa de dibujo en el dibujo donde desee dibujar dibujos de clean up. Cuando haya
terminado la limpieza, simplemente puede desactivar la capa que contiene el boceto de animacién para que no
aparezca en la animacidn final. Este enfoque también permite mantener los bocetos y los dibujos de clean up

intactos y administrarlos de manera independiente.

En la vista de cdmara, vera el boceto de animacién mientras trabaja en la capa de clean up. Si prefiere trabajar
en la vista de dibujo, puede habilitar la mesa de luz para mostrar el boceto de animacién mientras realiza

trazados en la capa de clean up.

Trazado de la animacién en una nueva capa

1. Enlavista de linea de tiempo, cambie el nombre de la capa en la que cred el boceto de animacion
haciendo doble clicen sunombre e introduciendo el nuevo nombre, por ejemplo: "Boceto".

2. Enlavista delinea de tiempo, agregue una capa realizando una de las siguientes acciones:

« Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clicen el
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botén Add Drawing Layer (Agregar capa de dibujo) # .
o Pulse Ctrl + R (Windows/Linux) o0 & + R (macOS).

Se abre la capa Add Drawing Layer (Agregar capa de dibujo).

Add and Close

2. En el campo Name (Nombre), escriba el nombre de la nueva capa, por ejemplo: "Clean-up".
3. Hagaclicen Add and Close (Agregar y cerrar) para agregar una nueva capa y cerrar la ventana.

Se agrega a la vista de linea de tiempo una nueva capa de dibujo.

4. En lavista de linea de tiempo, haga clicen el icono Lock (Bloquear) de la capa que contiene el
boceto de animacién para impedir que dicha capa se pueda seleccionar en la vista de cdmara.

5. Enlavista de linea de tiempo o de carta de rodaje, seleccione la celda de la nueva capa que
corresponda al primer dibujo clave del boceto de animacidn.
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6. Enlabarrade herramientas Tools (Herramientas), seleccione una herramienta de dibujo, como la

herramienta Pencil (Lapiz) # .

7. En lavista de color, seleccione un color para trazar la animacién. Seleccione un color oscuro intenso,
como el negro, para asegurarse de conseguir un contraste adecuado con el color claro del boceto de

animacion.

8. En lavista de cdmara o de dibujo, comience a trazar el primer dibujo clave.

NOTA

Si las capas de superposicion estan en medio, puede deshabilitarlas
temporalmente haciendo clic en su botén Enable/Disable (Habilitar/deshabilitar)
OO en la vista de linea de tiempo para que solo se muestren el boceto de

animacion y las capas de clean up.

9. Enlavista de linea de tiempo o de carta de rodaje, seleccione la siguiente celda que corresponda a

un boceto de dibujo.

10. Enlabarra de herramientas Tools (Herramientas), haga clic en el botén Enable Onion Skin (Activar

papel cebolla) = .

11. Asegurese de que el papel cebolla muestre el dibujo de clean up anterior realizando una de las

siguientes acciones:

« Enlavista de linea de tiempo, arrastre los marcadores azules de papel cebolla para
ampliar el nimero de dibujos anteriores y siguientes para que se visualicen como papel

cebolla.
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o Enlabarrade herramientas Camera View (Vista de cdmara) o Drawing View (Vista de
dibujo), utilice los botones Onion Skin Add One Previous Drawing (Agregar un dibujo
anterior de papel cebolla) <, Onion Skin Reduce One Previous Drawing (Reducir un
dibujo anterior de papel cebolla) <=, Onion Skin Reduce One Next Drawing (Reducir
un dibujo siguiente de papel cebolla) = y Onion Skin Add One Next Drawing
(Agregar un dibujo siguiente de papel cebolla) = para ajustar la extensién del papel
cebolla fotograma a fotograma.

12. En lavista de cdmara, trace el siguiente dibujo.

13. Repita los pasos anteriores para cada dibujo.
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Capitulo 8: Importacion de imagenes

De forma predeterminada, Harmony trabaja con imdgenes vectoriales creadas dentro de su propia interfaz. Las
imadgenes vectoriales se componen principalmente de informacidn sobre las distintas formas que componen las
imdgenes, asi como de sus colores de linea y de relleno. Esto hace que sean ficiles de editar y pintar, y permite
redimensionarlas sin que afecte a la calidad de la imagen. Por el contrario, las imdgenes de mapa de bits se
componen de informacién de color sobre cada pixel individual que compone la imagen. Por lo tanto, son mds
adecuadas para imdgenes muy detalladas o realistas, pero no se pueden escalar sin perder calidad de imagen.

Normalmente, es necesario trabajar con imdgenes de mapa de bits si debe crear algunos de los recursos de
escena, como fondos o props, en un software diferente. A continuacion, puede importar los archivos de
imdgenes de mapa de bits en su escena de Harmony.

Al importar una imagen de mapa de bits, debe decidir cdmo debe procesarla Harmony. Puede elegir entre las
siguientes opciones:

« Import as Bitmap (Importar como mapa de bits): Importa la imagen exactamente tal como estd y
garantiza que no se pueda modificar cuando se trabaje en la escena. Esta opcidn es Util para utilizar
fondos creados en el proyecto con un software diferente.

o Vectorize (Vectorizar): Convierte un mapa de bits en un dibujo vectorial de Toon Boom que se puede
pintar y editar facilmente con las herramientas de dibujo vectorial de Harmony. Esta opcidn puede ser
util para la importaciéon de capa de lineas escaneadas o creadas con un software diferente.

Importaciéon de una imagen de mapa de bits en su formato original

1. Realice una de las siguientes acciones:

« En el menu superior, seleccione File > Import > Images (Archivo > Importar >
Imagenes).

« Enlabarra de herramientas File (Archivo), haga clic en el botén Import Images
(Importar imagenes) =.

o En lavista de carta de rodaje, haga clic con el botén derecho en cualquier parte del
drea de fotogramas y seleccione Import > Images (Importar > Imdgenes).

Se abre el cuadro de didlogo Import Images (Importar imagenes).
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Cancel

2. Enla seccidn Files (Archivos) del cuadro de didlogo Import Images (Importar imagenes), haga clic en
Browse (Examinar) para buscar y seleccionar una o mas imagenes en el ordenador.

3. Agregue laimagen de mapa de bits a una nueva capa seleccionando la opcién Create Layer(s)
(Crear capas) y una de las siguientes opciones:

o Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imdgenes en ella.

o Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo dnico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se creardn dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendrd las dos primeras
imagenes, mientras que la "b" contendrd la tercera.

« Add to a Existing Layer (Agregar a una capa existente): Importa lasimdgenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacidn. Por ejemplo, si va a importar imdgenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

4. En la seccién Vectorization (Vectorizacidn), asegurese de que la opcién Vectorize Image (Vectorizar
imagen) no esté activada.

5. Hagaclicen OK (Aceptar).
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NOTA

De forma predeterminada, las imdgenes de mapa de bits se mostraran en baja resolucion en la
vista de cdmara para evitar que afecten al rendimiento de la reproduccién. También puede
ajustar la calidad de visualizacidon de una imagen de mapa de bits selecciondndola con la
herramienta Transform (Transformar) y, a continuacidn, abriendo el cuadro de didlogo Bitmap
Image Quality (Calidad de la imagen de mapa de bits) a través de View > Bitmap File Quality
(Vista > Calidad del archivo de mapa de bits). También puede previsualizar la imagen de mapa
de bits en la resolucién de la escena activando el modo Render Preview (Vista previa de
render) en la vista de cdmara.

Vectorizacion de imagenes

Harmony permite importar imadgenes como dibujos vectoriales. Los dibujos vectoriales se pueden pintar y editar
facilmente con las herramientas de dibujo vectorial de Harmony. Esto puede ser (til para la importacion de
capas de lineas escaneadas o creadas con un software diferente, ya que luego puede pintarlas en Harmony.

Importacidn y vectorizacién de una imagen de mapa de bits

1. Realice una de las siguientes acciones:

« En el menu superior, seleccione File > Import > Images (Archivo > Importar >
Imdgenes).

« Enlabarra de herramientas File (Archivo), haga clic en el botén Import Images
(Importar imagenes) .

« Enlavista de carta de rodaje, haga clic con el botén derecho en cualquier parte del
area de fotogramasy seleccione Import > Images (Importar > Imagenes).

Se abre el cuadro de didlogo Import Images (Importar imagenes).
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Cancel

1. En la seccién Files (Archivos) del cuadro de didlogo Import Images (Importar imdgenes), haga clicen
Browse (Examinar) para seleccionar una o mds imagenes del ordenador.

2. Seleccione el destino de las imdgenes:

o Create Single Layer Named (Crear una sola capa con nombre): Crea una nueva capa
con el nombre especificado e importa las imdgenes en ella.

« Create Layer(s) Based on Filenames (Crear capas basadas en nombres de archivo):
Crea una capa basada en cada prefijo de nombre de archivo Unico. Por ejemplo, si
importa tres archivos llamados a-1.tga, a-2.tga y b-1.tga, se crearan dos capas, una
denominada "a" y otra denominada "b". La capa "a" contendra las dos primeras
imdgenes, mientras que la "b" contendrd la tercera.

« Add to a Existing Layer (Agregar a una capa existente): Importa las imagenes en la
capa especificada. Tenga en cuenta que solo puede importar en las capas que son
compatibles con las opciones de importacién. Por ejemplo, si va a importar imagenes
como dibujos vectoriales, solo puede importarlas en capas de dibujos vectoriales.

3. Enla seccién Vectorization (Vectorizacién), seleccione la opcién Vectorize Image (Vectorizar
imagen).

4. Seleccione una de las siguientes opciones:

» Colour (Color): Importa mapas de bits como objetos vectoriales con suimagen como textura de
mapa de bits. El dibujo resultante se puede dibujar o borrar, pero no se puede volver a pintar o
ajustar.

» Black and White (Blanco y negro): Vectoriza los dibujos con una linea negra sdlida. Crea un
dibujo 100 % basado en vectores y lo pinta con la muestra de color de la linea vectorizada a
partir de la paleta de la escena.
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5. Siha seleccionado la opcién Black and White (Blanco y negro), establezca los siguientes pardmetros:

Pardmetro Descripcién

Determina qué valores de laimagen escaneada se considerardn
parte del dibujo, y qué se ignorard y eliminara del dibujo

Threshold (Umbral) . i L
vectorizado. Cuanto menor sea el valor, mas oscura sera la imagen

y viceversa.

Determina la suavidad de las lineas. Cuanto menor sea el valor,
Smooth (Suavizar) mds detalle se conservard. Cuanto mayor sea el valor, mas pulidas
y faciles de editar serdn las lineas.

6. Hagaclicen OK (Aceptar).

Las imdgenes vectorizadas apareceran en los destinos seleccionados.

NOTA

Si tiene imagenes de mapa de bits en la librerfa, puede arrastrarlas y colocarlas directamente en la
escena como una manera rapida de importar una imagen de mapa de bits. Sin embargo, no tendrd
acceso a todas las opciones de importacion.
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Capitulo 9: Configuracion de una escena

La configuracién de una escena se puede comparar con la construccién de la escenografia para un programa de
televisién. Este es el punto en el que coloca el elemento de escena, como el encuadre de cdmara, los elementos

de fondo vy los personajes.

Adicion de una camara

De forma predeterminada, una escena no tiene capa de cdmara. Para poder ajustar el angulo de la cdmaray la
posicién de la escena, debe agregar una a su escena. Aunque es posible tener varias cdmaras en la misma
escena, solo puede ver la escena utilizando las cdmaras de una en una. Esto puede resultar Gtil si adn esta
trabajando en la composicidn de escena y tiene distintas configuraciones de cdmara para probar.

Adicién de una camara en la vista de linea de tiempo o en el menu superior

1. Realice una de las siguientes acciones:

« Enlavista de linea de tiempo, haga clicen el botén Add Layer (Agregar capa) y
seleccione Camera (Cdmara).

« En el menu superior, seleccione Insert > Camera (Insertar > Camara).

Se agrega a la escena una nueva capa de camara y aparece en la vista de linea de tiempo.

ro=al
o

o

Cambio entre cdmaras

1. En el menu superior, seleccione Scene > Camera (Escena > Cédmara).

2. Entrelas cdmaras en la lista, seleccione la cdmara con la que desea trabajar.

Colocacién de la camara

La accidén de la escena tiene lugar dentro del encuadre de cdmara, de modo que es muy importante configurarlo
correctamente. Puede ajustar la resolucién de la cdmara y otros pardmetros relacionados en la ventana Scene
Settings (Configuracion de escena), a la que se puede acceder desde el menu superior Scene (Escena).

Tenga en cuenta que la capa de cdmara es estdtica. Si necesita animarla, debe colocarla debajo de un peg que
puede animar (consulte Animacion de la cdmara en la pdgina 61).

Puede cambiar la posicién del encuadre de cdmara directamente en la vista de cdmara utilizando las
herramientas Translate (Traslacién) <i-, Rotate (Rotar) &y Scale (Escalar) & de la barra de herramientas
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Advanced Animation (Animacién avanzada). Otra forma de configurar la cdmara es escribiendo las
coordenadas directamente en las propiedades de la cdmara. Esto puede ser Util si ha planificado la escena en
papel, ya que las coordenadas coinciden con las de una cuadricula de cdmara de animacién tradicional. Por lo
tanto, el uso de este enfoque permite colocar la cdmara exactamente donde desee.

Cambio de lugar del encuadre de camara en la vista de camara

1. Enlabarrade herramientas Tools (Herramientas), desactive el modo Animate (Animar)
2. Realice una de las siguientes acciones:

« En el menu superior, seleccione Animation > Tools > Translate (Animacién >
Herramientas > Traslacién).

« Enlabarrade herramientas Advanced Animation (Animacién avanzada), haga clicen
la herramienta Translate (Traslacién) <.

o Pulse Alt + 2.

3. Enlavista de cdmara, haga clic en el encuadre de cdmara (rectangulo delgado) para seleccionarlo.
También puede seleccionar la capa de cdmara en la vista de linea de tiempo.

Se resalta el encuadre de cdmara seleccionado.

4. Arrastre el encuadre de cdmara a una nueva posicion.
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5. Pararotar el encuadre de cdmara, realice una de las siguientes acciones para seleccionar la
herramienta Rotate (Rotar):

« En el menu superior, seleccione Animation > Tools > Rotate (Animacidn >
Herramientas > Rotar).

o Enlabarrade herramientas Advanced Animation (Animacién avanzada), seleccione la
herramienta Rotate (Rotar) &'.

o Pulse Alt + 3.

6. Enlavista de cdmara, arrastre para rotar el encuadre de cdmara hasta que alcance el angulo de
rotacién deseado.

©
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7. Para mover el encuadre de cdmara mas cerca o mas lejos de la escena, realice una de las siguientes
acciones para seleccionar la herramienta Scale (Escalar):

« En el menu superior, seleccione Animation > Tools > Scale (Animacién > Herramientas
> Escalar).

o Enlabarrade herramientas Advanced Animation (Animacién avanzada), seleccione la
herramienta Rotate (Rotar) & .

o Pulse Alt + 4.

NOTA

La herramienta Transform (Transformar) también se puede utilizar para mover la cdmara, pero
no para rotarla o escalarla.

Colocacion de objetos

La configuracién de la escena también implica la colocacién de los distintos elementos de la escena dentro del
encuadre de cdmara.

Paneo de una capa con la herramienta Transform (Transformar)
1. Enlabarrade herramientas Tools (Herramientas), desactive el modo Animate (Animar)

2. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Transform
(Transformar) i o pulse Mayus + T.
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En la vista de propiedades de la herramienta, asegurese de que esté desactivada la opcién Peg
Selection Mode (Modo de seleccidn de peg) & .

En la vista de cdmara, seleccione una capa de dibujo. Si desea seleccionar varias capas, mantenga
pulsada la tecla Mayus y haga clic en cada capa que desee seleccionar.

Arrastre la seleccidn a una nueva drea.

Rotacion de una capa con la herramienta Transform (Transformar)

En la barra de herramientas Tools (Herramientas), desactive el modo Animate (Animar)

En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform
(Transformar) i o pulse Mayus + T.

En la vista de propiedades de la herramienta, asegurese de que esté desactivada la opcién Peg
Selection Mode (Modo de seleccidn de peg) & .

En la vista de cdmara, seleccione una capa de dibujo. Si desea seleccionar varias capas, mantenga
pulsada la tecla Mayus y haga clic en cada capa que desee seleccionar.

Cologue el puntero fuera de una esquina del cuadro de limite y, a continuacidn, arrdstrelo para rotar.

Escalado de una capa con la herramienta Transform (Transformar)

1. Enlabarrade herramientas Tools (Herramientas), desactive el modo Animate (Animar)

2. Enlabarra de herramientas Tools (Herramientas), seleccione la herramienta Transform

(Transformar) i o pulse Mayus + T.
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3. Enlavista de propiedades de la herramienta, aseglrese de que esté desactivada la opcidn Peg
Selection Mode (Modo de seleccidn de peg) & .

4. En lavista de cdmara, seleccione una capa de dibujo. Si desea seleccionar varias capas, mantenga
pulsada la tecla Mayus y haga clic en cada capa que desee seleccionar.

5. Hagaclicy arrastre el punto de control superior, lateral o de esquina.

NOTA

Al realizar el escalado de la seleccidén, puede mantener pulsada la tecla MayUs para mantener
las proporciones entre la anchura vy la altura.

Sesgo de una capa con la herramienta Transform (Transformar)

1. Enlabarrade herramientas Tools (Herramientas), desactive el modo Animate (Animar)

2. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Transform
(Transformar) i o pulse Mayus + T.

3. Enlavista de propiedades de la herramienta, aseglrese de que esté desactivada la opcidn Peg
Selection Mode (Modo de seleccidn de peg) & .

4. En lavista de cdmara, seleccione una capa de dibujo. Si desea seleccionar varias capas, mantenga
pulsada la tecla Mayus y haga clic en cada capa que desee seleccionar.

5. Sitde el puntero sobre el borde del cuadro de limite de la seleccién, entre dos puntos de control, y
arrastrelo hacia los lados o arriba y abajo.

Dibujo original Cursor colocado entre Cursor colocado entre
puntos de confrol y puntos de control y
arrastrado hacia arriba amasfrado hacia los lados
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Cambio de posicién del pivote

Las transformaciones realizadas sobre una capa de dibujo, tales como rotacidn, escala, sesgo y volteo, se
realizan respecto a la posicién del punto de pivote del dibujo. Mientras realiza transformaciones con la
herramienta Transform (Transformar), puede arrastrar y colocar el pivote de la seleccién. Sin embargo, esto no
tiene un efecto permanente. Solo cambiard temporalmente la posicidn del pivote para que le ayude a realizar
transformaciones en el fotograma seleccionado, pero el punto de pivote real de la capa de dibujo permanecerd
igual. Puede cambiar de forma permanente la posicion del punto de pivote de una capa utilizando las
herramientas de animacién avanzada.

Cambio de posicion permanente del punto de pivote

1. Enlabarrade herramientas Advanced Animation (Animacién avanzada), seleccione la herramienta
Translate (Traslacién) <>, Rotate (Rotar) &, Scale (Escalar) & o Skew (Sesgar) /7.

2. En lavista de cdmara, Ctrl + clic (Windows/Linux) o 3£ + clic (macOS) para seleccionar el elemento.

El punto de pivote aparece en la vista de cdmara.

Funto de pivote

3. Arrastre el punto de pivote a una nueva posicidn.
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NOTA

Al mover de forma permanente el punto de pivote de una capa que ya estd animada, todas las
transformaciones realizadas en la capa en otros fotogramas clave se volveran a calcular de
acuerdo con la posicién del nuevo punto de pivote. Por lo tanto, la animacién existente parecera
completamente diferente, excepto en el fotograma actual. Es recomendable que siempre se
asegure de que el punto de pivote se encuentre en la posicién idénea antes de comenzar la
animacion.
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Capitulo 10: Animacion de objetos y de la camara

En Harmony, puede animar objetos dibujandolos en su capa individual y colocdndolos a continuacién en
distintas ubicaciones en diferentes fotogramas clave a través de la linea de tiempo para crear una ruta de
movimiento. Se puede aplicar el mismo principio a la cdmara de la escena, ya que se trata de una capa.

Animacion de una capa

Puede crear la ruta de movimiento directamente en capas (capas animadas).

Puede controlar y definir una trayectoria utilizando varios pardmetros distintos, incluidos:
o Posiciones X,YyZ
« Angulo (rotacién)
o Sesgar
o EscalasXeY

Harmony mantiene el desglose de la animacién almacenando cada pardmetro de cada capa en su propia curva
de funcidn. Al agregar un fotograma clave a una capa, se crea un fotograma clave en cada una de estas
funciones y las transformaciones realizadas en una capa mediante la vista de cdmara se convierten en
coordenadas, que a continuacién se almacenan en dichas funciones. Es posible editar estas funciones de
manera individual con la vista de funcién, pero no suele ser necesario, ya que Harmony ofrece herramientas
faciles de usar para controlar visualmente las trayectorias y el tiempo en las vistas de cdmara y linea de tiempo.
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Expandir/contraer parametros

Parametros Valores

Animacién de una capa o un peg

1. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Transform
(Transformar) i o pulse Mayus + T.

2. Sila capatiene un peg padre y desea animar la capa de dibujo directamente, asegurese de que el
modo Peg Selection (Seleccidon de peg) & esté deshabilitado en la vista de propiedades de la
herramienta.

3. Enlabarrade herramientas Tools (Herramientas), active el modo Animate (Animar) < . Esto
permite que la herramienta Transform (Transformar) afecte a la posicién y al tamafio de una capa
solo en el fotograma clave actual, mientras que, en caso contrario, afectaria a la posicién y al tamafio
de la capa en toda la escena.

4. Enlavista de linea de tiempo, vaya al primer fotograma.

5. En el mend superior, seleccione Animation (Animacidn) y aseglrese de que la opcién Stop-Motion
Keyframe (Fotograma clave de Stop-motion) no esté activada. De este modo, Harmony creard la
animacién automdaticamente entre los fotogramas clave de la animacién que cree.

6. Seleccione la celda donde desee crear el primer fotograma clave.
7. Para crear el primer fotograma clave, realice una de las siguientes acciones:

o Enlabarrade herramientas Timeline (Linea de tiempo), haga clicen el botén Add
Keyframe (Agregar fotograma clave) * .

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.

Se crea un fotograma clave en el primer fotograma de la vista de linea de tiempo.
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Fotograma clave

8. En lavista de cdmara, seleccione el elemento que desea animar y muévalo a su primera posicidn.

9. Enlavista de linea de tiempo, vaya al fotograma en el que desea establecer la segunda posicién.

10. Seleccione la celda donde desee crear el segundo fotograma clave. Haga clic con el botén derecho en
la seleccidn y seleccione Insert Keyframe (Insertar fotograma clave).

Aparece el segundo fotograma clave junto con una linea que va desde el primer fotograma clave al
segundo fotograma clave. Esto indica que Harmony interpolard cada fotograma intercalado.

rno=am
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Fotograma clave

11. En lavista de cdmara, mueva el elemento a su segunda posicién.
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12. Enlavista de linea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la

animacion.

13. Enlabarra de herramientas Playback (Reproducir), haga clic en el botdn Play (Reproducir) » para
obtener una vista previa de la animacién.

NOTA

Si anima capas en el eje Z, puede que desee obtener una vista previa de las animaciones desde
las vistas superior o lateral durante la reproduccién. Sin embargo, la reproduccién estd
deshabilitada de forma predeterminada en esas vistas. Para habilitarla, en el mend superior
seleccione Play > Enable Playback > Top View (Reproducir > Activar reproduccién > Vista
superior) o Side View (Vista lateral).

Animacion de la camara

La cdmara de una escena se puede manipular y animar como cualquier otra capa. Se muestra en la vista de lihea
de tiempo y puede utilizar las mismas herramientas y modos de seleccidn para desplazarla o animarla. Sin
embargo, la capa de la cdmara en si es estdtica, lo que significa que mantiene la misma posicién y dangulo en toda
la escena. Para poder animar la cdmara, es necesario conectarla a una capa de peg, que se puede animar, y que
afectard directamente a la posicion y al angulo de la cdmara.

ro=al

o L]
o

Puede animar los movimientos de la cdmara directamente en la vista de cdmara. También puede utilizar las
vistas lateral o superior, que pueden ser especialmente Utiles al animar una cdmara en una escena de
multiplano, donde cada capa se coloca a una distancia diferente de la cdmara.
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Apertura de las vistas superior y lateral

1. Realice una de las siguientes acciones:

o En el menu superior, seleccione Windows > Top (Ventanas > Superior) o Side
(Lateral).

« Desde cualquier vista que ya esté abierta, haga clic en el botén Add View (Agregar
vista) situado en la esquina superior derecha y seleccione Top (Superior) o Side
(Lateral).

Adicion de una camara y su peg padre

1. De forma predeterminada, las nuevas escenas no tienen una capa de cdmara. Para agregar una
capa de cdmara, realice una de las siguientes acciones:

« En el menu superior, seleccione Insert > Camera (Insertar > Camara).

o Enlabarrade herramientas Layers (Capas), haga clicen el botén Add Layers (Agregar
capas) + y seleccione Camera (Cdmara).

Se agrega a la escena una nueva capa de camara y aparece en la vista de linea de tiempo.

2. Enlavista de linea de tiempo, seleccione la capa de cdmara.

3. Enlabarra de herramientas Layers (Capas), haga clic en el botén Add Peg (Agregar peg) .

Aparece una capa de peg directamente sobre la capa de cdmara y se conecta a ella
automaticamente. La nueva capa de peg toma el nombre de la capa de cdmara con el sufijo -P
agregado para indicar que se trata de su capa de peg.

Capa de peg contraida Capa de peg expandida

o+ [+ [+ +

Si la nueva capa de peg no aparecia directamente encima de la cdmara, puede que haya hecho clic
en algun otro lugar de la escena que desactivase la capa a la que desea agregar la capa de peg. Para
resolverlo:
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« Seleccione la capa de camara vy arrastrela y coléquela debajo de la nueva capa de peg.
O bien, elimine la capa de peg mal colocada, seleccione la capa de cdmara y haga clic
de nuevo en el botén Add Peg = (Agregar peg).

También puede pulsar Ctrl + P (Windows/Linux) o &£ + P (macOS) para crear un peg y
conectarlo a la cdmara.

Animacion de la cdmara

1. Enlabarrade herramientas Tools (Herramientas), active el modo Animate (Animar)

2. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Transform
(Transformar) i o pulse Mayus + T.

3. Enelladoderechode la vista de linea de tiempo, en la capa de peg de cdmara, seleccione el
fotograma en el que desee que comience el movimiento de cdmara.

ro=al
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4. Realice una de las siguientes acciones para agregar un fotograma clave:

« Enlabarrade herramientas Timeline (Linea de tiempo), haga clic en el botén Add
Keyframe (Agregar fotograma clave) * .

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.

Aparece un fotograma clave en dicha celda. Los fotogramas que preceden a este fotograma clave
mantendran la misma posicién de cdmara gque este fotograma clave.

5. Realice una de las siguientes acciones para mover la cadmara:

o En lavista de cdmara, seleccione la cdmara, que ahora se representa con un rectdngulo
delgado y amarillo con un resaltado rojo, y muévalo a la posicidon deseada.
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« En la vista superior o lateral, seleccione la cdmara, que ahora se representa con un cono
grande y amarillo en forma de V, y muévalo a la posicién deseada.

6. Enlavistadelinea de tiempo, haga clicen la celda en la que terminara el movimiento de camara.
7. Realice una de las siguientes acciones:

o Enlabarrade herramientas Timeline (Linea de tiempo), haga clic en el botén Add
Keyframe (Agregar fotograma clave) * .

« Haga clic con el botén derechoy seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.

Aparece un fotograma clave en dicha celda.
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8. Seleccione la cdmara en la vista de cdmara, superior o lateral, y muévala a la posicién deseada.

9. Enlavistadelinea de tiempo, seleccione el primer fotograma para retroceder al comienzo de la
animacion.

10. En la barra de herramientas Playback (Reproducir), haga clic en el botdn Play (Reproducir) » para
obtener una vista previa de la animacién.
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Capitulo 11: Creacidn de un rig de un personaje Cut-
out

En Harmony, un rig de personaje es basicamente una plantilla basada en el modelo del personaje, peroen la
cual todas las partes mdviles estan divididas en distintas capas y ordenadas en una jerarquia que facilita la
animacién digital, también conocida como animacidén cut-out.

Para realizar un rig de personaje, en primer lugar debemos asegurarnos de tener un modelo de personaje del
que partir. Si tiene un dibujo de un personaje disponible, impdrtelo en una nueva escena'y, a continuacion,
ajuste la escala y coldéquelo a su gusto. De lo contrario, puede dibujar el modelo del personaje directamente en
Harmony. Una vez que tenga listo un modelo, podemos comenzar a descomponerlo en partes para crear el rig
con él.

Se pueden emplear muchas técnicas para descomponer una marioneta. En esta seccidén, aprenderd uno de los
métodos mas comunes y sencillos. Para la primera descomposicién de personaje, siga estas instrucciones para
hacerse una idea de cémo funciona Harmony. Una vez que conozca las funciones y comandos bdsicos de
Harmony, podra crear sus propias técnicas para cumplir las necesidades de su produccidn.

7!

N

Dibujo de las piezas

La técnica de descomposicidn principal que se muestra es el trazado del modelo.

Descomposicion de un personaje mediante trazado

1. Enlavista de linea de tiempo, aflada una nueva capa de dibujo para cada parte del cuerpo que
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desee separar. Puede pulsar Ctrl + R (Windows/Linux) o & + R (macOS).

+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1
+ 1

3. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta de dibujo que desee. Se
suelen utilizar dos métodos para dibujar las partes de un modelo de personaje cut-out:

« Utilizar la herramienta Pencil (Lépiz) # vy suavizar las lineas con la herramienta
Smooth Editor (Editor de suavidad) X .

« Utilizar la herramienta Polyline (Polilinea) S . Este método permite dibujar con gran
precisidn, pero puede llevar mas tiempo.

Estos métodos garantizan que cada parte se realice con el menor ndmero de puntos posible, para
que sean faciles de manipular, modificar o volver a dibujar.

4. En lavista de color, seleccione una muestra de color. Si todavia no ha creado ninguna paleta para el
personaje, consulte Cémo pintar en la pagina 28.

5. Siprefiere trabajar en la vista de dibujo, realice una de las siguientes acciones para mostrar las
demds capas con colores lavados:

o Enlabarrade herramientas de la vista de dibujo, haga clic en el botén Light Table
(Mesa de luz)

o Pulse MayUs + L.

6. Enlavista de cdmara o de dibujo, dibuje la nueva parte.
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7.

10.

Si desea cerrar una forma abierta sin dibujar un contorno visible, puede dibujar una linea visible con
la herramienta Stroke (Linea vectorial transparente) (.

NOTA

Las lineas vectoriales transparentes no son visibles de forma predeterminada. Para ver
las lineas vectoriales transparentes en el dibujo, seleccione View > Show > Show
Strokes (Ver > Mostrar > Mostrar lineas vectoriales transparentes) en el menu superior o
pulse K.

En la barra de herramientas Tools (Herramientas), seleccione la herramienta Paint (Pintar) ® o
pulse Paint Unpainted (Pintar despintado) ® para colorear el dibujo.

En la vista de color, cree el color de relleno deseado si no se encuentra todavia en la paletay, a
continuacion, selecciénelo.

En la vista de cdmara o de dibujo, pinte el dibujo.
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11. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Select (Seleccionar) % .

Seleccione el dibujo y acople las lineas haciendo clic en el botén Flatten (Acoplar) = de la vista de
propiedades de la herramienta.

12. Repitatodo el proceso para cada parte del cuerpo que desee que se pueda animar.
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Adicion de pegs

Los pegs son un tipo especial de capa que no contiene ningun dibujo. Solo se utilizan para desplazary
transformar dibujos que estén debajo su jerarquia, sin transformar directamente los dibujos.

Al crear un rig o configurar una escena, se recomienda anadir pegs padres a cada una de las capas de dibujo.
Esto permite mantener los fotogramas clave y los dibujos de animacién en capas separadas, lo que facilita el
trabajo sobre la posicidn y exposicion de las capas de dibujo por separado en la vista de linea de tiempo.
También facilita la creacién de una jerarquia de las partes del cuerpo que se pueden animar juntasy por
separado.

Si desea animar solo sobre pegs, puede activar el modo Peg Selection (Seleccién de peg) de la herramienta
Transform (Transformar) en la vista de propiedades de la herramienta. También puede deshabilitar las capas de
dibujo de animacidén, de forma que solo se puedan animar los pegs.

NOTA
También es posible hacer que una capa de dibujo esté emparentada con otra capa de dibujo. Al

igual que la forma de animacién de un peg anima sus capas hijas, la animacién de una capa de dibujo
con hijas también animard sus capas hijas. Ambas capas seguirdn apareciendo en la animacion.

Creacion de pegs padres para las capas en la vista de linea de tiempo

1. Enlavista de linea de tiempo, seleccione todas las capas.

+
|

¥

#

+++H++

L]
L]
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2. Enlabarrade herramientas Timeline Layer (Capa de linea de tiempo), haga clic en el botén Add Peg
(Agregar peg) (% para agregar un peg padre a todas las capas seleccionadas.
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+ - + %

+

Creacion de una jerarquia de capas

Harmony permite crear el rig en una jerarquia elaborada, lo que le permite a su vez establecer qué partes del rig
deben influir en otros miembros y cémo pueden moverse de forma independiente. Por ejemplo, al crear un rig
del brazo de un personaje simple, puede hacer que la capa del antebrazo sea hija de la capa del brazo, y que la
capa de la mano sea hija de la capa del antebrazo. De esta manera, si el personaje mueve el antebrazo, la mano
también lo hard, y si mueve el brazo, el antebrazoy la mano también lo haran.

Jerarquia de brazo —# - Jerarquia de brazo

derecho izquierdo
Jerarquia de piema = - Jerarquia de pierna
derecha izquierda

Al crear un rig de personaje bdsico, debe tener al menos una jerarquia para cada brazo y cada pierna. Puede
crear una jerarquia que vaya desde el torso, el cuelloy la cabeza, y crear un rig de los brazos al torso y otro de las
piernas a las caderas. Esto crearia una jerarquia como esta:
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Creacidn de una jerarquia en la vista de linea de tiempo

1. En el dreaizquierda de la vista de linea de tiempo, seleccione la capa que desee que sea la capa hija.

2. Arrastre la hija y coléquela sobre la capa que desee que sea la capa padre. Aseglrese de no colocar
la capa hija entre dos capas.

3. Repita el proceso hasta que haya creado una jerarquia que cree un rig de todas las partes del
personaje, con un peg maestro en la raiz. Al crear un rig, si desea que varias capas tengan un padre
comun, pero ninguna de las partes existentes del rig puede servir como dicho padre, cree un nuevo
peg y anide esas capas debajo de dicho peg.

Without pegs

*
+
+
+
+
+
+
+
+

NOTA

En la vista de linea de tiempo, puede desconectar una capa de su capa padre manteniendo
pulsada la tecla Mayus, arrastrando la capa padre lejos de la capa hija y colocandola en
cualquier lugar de la lista.

72



Guia de introduccién de Toon Boom Harmony 15 Essentials

Al crear un rig, tenga en cuenta que el orden de las capas en la vista de linea de tiempo afecta al orden en que
se representan. Las capas de la parte superior de la lista se representardn sobre las capas de la parte inferior de
la lista. Si tiene que cambiar el orden de una capa durante la animacién, puede realizar un desplazamiento
pequefio de la posicidn de esta capa sobre el eje Z para anular el orden de la capa y forzarla a aparecer debajo
de otras capas o sobre ellas.

Desplazamiento pequefio de una capa sobre el eje Z

1. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Transform
(Transformar) i.i.

2. Enlavista delinea de tiempo, de nodos o de camara, seleccione la capa que desea desplazar.

3. Siha seleccionado la capa en la vista de linea de tiempo o de nodos, haga clic en la pestana de la
vista de cdmara para establecer el enfoque en esta vista.

4. Realice una de las siguientes acciones:

o Pararealizar un desplazamiento pequeno de la capa hacia delante, pulse Alt + flecha
abajo.

o Pararealizar un desplazamiento pequefio de la capa hacia atrds, pulse Alt + flecha
arriba.

Peg maestro

El rig del personaje siempre debe tener un peg maestro que se conecte a todas sus partes. El peg maestro
permite manipular todo el rig desde una Unica capa, sin necesidad de manipular cada parte individual. Esto es
(til para colocar y escalar el personaje en relacidn a la escena, asi como para animar la trayectoria del personaje
cuando tiene que moverse entre las dreas de la escena.
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Adicion de un peg maestro en la vista de linea de tiempo

1. Enlavista de linea de tiempo, seleccione la capa superior.
2. Enlavista delinea de tiempo, haga clic en el botén Add Peg (Agregar peg) = .

Se agrega a la linea de tiempo un nuevo peg al que queda emparentada la capa seleccionada.
3. Asigne el nombre Master mas el nombre del personaje al nuevo peg.

4. En lavista delinea de tiempo, seleccione todas las capas que desee conectar al nuevo peg. Recuerde
gue la capa superior ya es hija del peg, asi que no la incluya en la seleccién.

5. Arrastre la seleccion SOBRE la capa del peg para emparentar todas las piezas del personaje al peg.
Si se agregan capas encima de las capas que ya tienen padres, mueva dicha capa con padres de
nuevo a la parte superior de la pila de capas.
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Capitulo 12: Animacion de un personaje Cut-out

Harmony ofrece herramientas muy Utiles para animar modelos de personajes cut-out. Con la herramienta
Transform (Transformar), puede mover las partes del personaje para crear poses clave, mientras que Harmony
crea los intercalados. El tiempo del movimiento se puede ajustar para crear movimientos realistas y los dibujos
de las partes del personaje se pueden intercambiar en cualquier punto de la animacién, permitiendo combinar
los cambios del movimiento y del dibujo para crear animaciones cut-out perfectamente ajustadas.

Creacion de una animacién Cut-out simple

Crearemos una animacion Cut-out simple realizando la primera pose del personaje en el primer fotograma,
la segunda pose en el siguiente fotograma y permitiendo que Harmony las interpole.

1. Enlavista de linea de tiempo, contraiga el personaje con la flecha Expand/Collapse

(Expandir/Contraer).

3. Paragarantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicidn) realizando una de las siguientes acciones:

« Haga clic con el botén derecho en el primer fotograma de la vista de linea de tiempo y
seleccione Extend Exposure (Extender exposicion).
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e Pulse F5.

4. En el cuadro de didlogo Extend Exposure (Extender exposicidn), escriba el nimero de fotogramas de
la escena y confirme. De este modo, el modelo quedard expuesto (serd visible) en toda la escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mads tarde, la primera pose no se vea afectada. Para llevarlo a cabo, realice una
de las siguientes acciones:

o Enlabarrade herramientas Timeline (Linea de tiempo), haga clic en el botén Add
Keyframe (Agregar fotograma clave) * .

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.

Se agrega un fotograma clave al fotograma actual.

6. En labarra de herramientas Tools (Herramientas), seleccione la herramienta Transform

(Transformar) i o pulse Mayus + T.

7. Enlabarrade herramientas Tools (Herramientas), active el modo Animate (Animar) < . Esto
permite que la herramienta Transform (Transformar) afecte a la posicidn y al tamafio de una capa
solo en el fotograma clave actual, mientras que, en caso contrario, afectaria a la posicién y al tamafo
de la capa en toda la escena.

8. Enlavista de cdmara, seleccione las partes que desea animar. El cuadro de control de la herramienta
Transform (Transformar) aparecera alrededor de la capa seleccionada. Cada parte del cuadro de
control de la herramienta Transform (Transformar) se puede usar para realizar distintos tipos de
transformaciones:

Sesgar

Mover
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9.

10.

11.

12.

13.

Utilice la herramienta Transform (Transformar) ii para rotar, sesgar, escalar o trasladar la seleccién
a su nueva posicion.

Repitalo en otras partes del modelo del personaje hasta que la primera pose haya terminado.
En la barra de herramientas Tools (Herramientas), active la funcién Onion Skin (Papel cebolla) <.

En la vista de linea de tiempo, seleccione el fotograma donde desee tener la segunda pose.

Cree un fotograma clave para la segunda pose realizando una de las siguientes acciones:

o Enlabarrade herramientas Timeline (Linea de tiempo), haga clic en el botén Add
Keyframe (Agregar fotograma clave) * .

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.

Aparece el segundo fotograma clave junto con una linea que va desde el primer fotograma clave al
segundo fotograma clave. Esto indica que Harmony interpolard cada fotograma intercalado.

Si no aparece ninguna linea, significa que se ha creado el primer fotograma clave como un fotograma
clave de Stop-motion. Para resolverlo, realice una de las siguientes acciones:

« Haga clic con el botdn derecho en el primer fotograma clave y seleccione Set Motion
Keyframe (Definir fotograma clave de movimiento).

« Seleccione el primer fotograma clave y pulse Ctrl + K (Windows/Linux) o &8 + K (macOS).
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. Para asegurarse que los nuevos fotogramas clave se establezcan en Motion (Movimiento) de forma
predeterminada, seleccione Animation (Animacién) en el menu superior y asegurese de que la
opcidn Stop-Motion Keyframe (Fotograma clave de Stop-motion) no esté activada.

NOTA

Cada fotograma clave puede ser un fotograma clave de movimiento o un fotograma
clave de Stop-motion. Harmony interpola los fotogramas entre dos fotogramas clave si
el primero de los dos fotogramas clave es un fotograma clave de movimiento.

14. En lavista de cdmara, cambie de nuevo la pose del personaje.

15. Repita este proceso para todas las poses que desee agregar a la animacion.

Ajuste de la velocidad de la animacién
1. En lavista de linea de tiempo, contraiga la jerarquia del modelo del personaje.

2. Seleccione uno de los fotogramas clave de la animacién. Como la jerarquia del modelo estd contraida,

se selecciona el fotograma clave en cada capa simultdaneamente.

3. Realice una de las siguientes acciones:

o Enlavista de linea de tiempo, haga clic con el botdn derecho y seleccione Set Ease For

Multiple Parameters (Definir velocidad para varios parametros).
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« Enlabarrade herramientas Timeline (Linea de tiempo), haga clic en el botén Set Ease
For Multiple Parameters (Definir velocidad para varios parametros) = .

Se abre el cuadro de didlogo Set Ease For Multiple Parameters (Definir velocidad para varios

pardmetros).

Grafico =

4. En el gréfico, tire del controlador de la curva Bézier para ajustar la velocidad de todas las funciones

seleccionadas.

5. Para aplicar estos parametros de velocidad Unicamente a un tipo de funcién determinado, como
Rotation (Rotacidn) o Scale (Escala), en la seccién Filters (Filtros), anule la seleccién de los tipos de
funcidn a los que no desee que se apliquen.

« Motion (Movimiento): Aplica los pardmetros de velocidad a las funciones Position X
(Posicidn X), Position Y (Posicidn Y), Position Z (Posicién Z) y 3D Path (Ruta 3D)
seleccionadas.

« Rotation (Rotacién): Aplica los pardmetros de velocidad a las funciones de angulo
seleccionadas.
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« Scale (Escala): Aplica los pardametros de velocidad a las funciones de escala
seleccionadas.

o Skew (Sesgar): Aplica los pardmetros de velocidad a las funciones de inclinacién
seleccionadas.

« Morphing: Aplica los pardmetros de velocidad a las funciones de velocidad de
morphing seleccionadas. Tenga en cuenta que Morphing solo estd disponible
en Harmony Advanced y Harmony Premium.

o Other (Otras): Aplica los pardmetros de velocidad a todas las demds funciones
seleccionadas, como todas las funciones creadas para animar parametros de efecto.

6. También puede ajustar la velocidad introduciendo valores en los campos Time Ratio (Tasa de
tiempo) y Value Ratio (Tasa de valor). Los valores se calculan como un porcentaje.

e Enlos campos Left Time Ratio (Tasa de tiempo izquierdo) y Right Time Ratio (Tasa de
tiempo derecho), escriba el valor como porcentaje correspondiente al tiempo que
desea que dure la velocidad. El valor debe estar entre el 0 % y el 100 %.

o En los campos Left Value Ratio (Tasa de valor izquierdo) y Right Value Ratio (Tasa de
valor derecho), escriba el valor como porcentaje correspondiente a la intensidad que
desea que tenga la desaceleracion. El valor debe estar entre el 0 %y el 100 %.

« Silos valores Time Ratio (Tasa de tiempo) y Value Ratio (Tasa de valor) son iguales, el
movimiento serd lineal.

7. Haga clicen uno de los siguientes botones:

« Apply/Previous (Aplicar/anterior): Aplica los pardmetros de velocidad a los fotogramas
clave seleccionados y automdticamente se selecciona el fotograma clave anterior en la
linea de tiempo.

« Apply (Aplicar): Aplica los pardmetros de velocidad a los fotogramas clave
seleccionados.

o Apply/Next (Aplicar/siguiente): Aplica los pardmetros de velocidad a los fotogramas
clave seleccionados y automdticamente se selecciona el fotograma clave siguiente en la
linea de tiempo.

« Close (Cerrar): Cierra el cuadro de didlogo. Si no ha aplicado las modificaciones, se
cancelaran.

NOTA

Si se selecciona un rango que contiene varios fotogramas clave, solo el primer fotograma clave
seleccionado se verd afectado por la funcién Set Ease for Multiple Parameters (Definir velocidad
para varios parametros).
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Desplazamiento por las capas

Dado que la animacidn cut-out normalmente implica modelos complejos con amplias jerarquias, aprender los
atajos para desplazarse facilmente entre las capas puede ahorrar mucho tiempo.

Un truco de gran utilidad para aprender es el comando Centre on Selection (Centrar en seleccién), junto con su
atajo de teclado. Este comando permite desplazarse directamente a la capa seleccionada en la vista de linea de
tiempo. Por lo tanto, puede usar la vista de cdmara para seleccionar de forma visual la capa con la que desee
trabajar y, a continuacién, usar el atajo de Centre on Selection (Centrar en seleccién) para encontrar la capa en
la vista de linea de tiempo, en lugar de revisar la estructura de la escena para localizarla.

Centrado en la seleccion actual en la vista de linea de tiempo

1. Enlavista de linea de tiempo, contraiga todas las capas.

2. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Transform
(Transformar) ii.

3. Enlavista de cdmara, seleccione cualquier capa.
4. Realice una de las siguientes acciones:

« Hagaclicen la pestana de la vista de linea de tiempo para ajustar el centrado en la

misma y, a continuacion, pulse O.

« Enlabarrade herramientas de la vista de linea de tiempo, haga clic en el botén Centre
on Selection (Centrar en seleccién)

La vista de linea de tiempo estd ahora centrada en la capa seleccionada y todos sus padres se han
expandido automaticamente.

Si desea usar el atajo de teclado con frecuencia, le puede parecer que es cansado tener que hacer clicen la
pestafia de vista de linea de tiempo cada vez. Para resolverlo, puede habilitar la preferencia Focus On Mouse
Enter (Centrarse en ratdn). Ajustard el centrado en una vista en cuanto el cursor del ratén entre en ellay hard
funcionales al instante todos los atajos de teclado de esta vista.

Activacion de la preferencia Focus On Mouse Enter (Centrarse en raton)

1. En el menu superior, vaya a Edit > Preferences (Editar > Preferencias) (Windows/Linux) o Harmony
> Preferences (Harmony > Preferencias) (Mac OS X).

2. Abrala pestafa General.

3. Enla seccién Options (Opciones), active la casilla de verificacion Focus On Mouse Enter (Centrarse
en ratdn).

4. Haga clicen OK (Aceptar).

82



Guia de introduccién de Toon Boom Harmony 15 Essentials

Los atajos de teclado para vistas especificas funcionaran en cuanto el cursor del ratén entre en la

vista prevista.

Harmony también tiene comandos y atajos de teclado para cambiar rdpidamente la seleccién de la capa
seleccionada actualmente a su padre o hijo, permitiendo asf el desplazamiento con rapidez por la jerarquia del

personaje.

Seleccidn del padre o del hijo de la capa seleccionada

1. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Transform

(Transformar) 1.

2. En lavista de propiedades de la herramienta Transform (Transformar), asegurese de que esté

desactivado el modo Peg Selection (Seleccién de peg) « .

3. Enlavista de cdmara o de linea de tiempo, seleccione una capa u objeto conectado a una jerarquia.

)

Y

) O
[ ]

)

4. Realice una de las siguientes acciones:

« Seleccione Animation > Select Parent (Animacién > Seleccionar padre) o pulse B para

seleccionar la capa padre.

o Seleccione Animation > Select Child (Animacidn > Seleccionar hijo) o pulse Maydus + B

para seleccionar la capa hija.
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Capitulo 13: Uso de deformadores

Los deformadores permiten animar objetos y partes de un modelo de personaje mediante las deformaciones
generadas por ordenador. Permite doblar o distorsionar los dibujos sin necesidad de volver a dibujarlos. Cuando
se usa en una animacion cut-out, puede ampliar notablemente una gama de movimientos y poses que un
modelo de personaje pueda conseguir sin necesidad de haber dibujado ninguna de sus partes en diferentes
poses, lo que supone un ahorro de tiempo y hace que la animacidén cut-out parezca mucho mds natural con

menos esfuerzo.

Los deformadores se pueden usar para deformar una Unica capa de dibujo o una jerarquia de capas, de manera
que un solo deformador se puede usar para deformar lo que sea desde un prop hasta un rig de personaje

completo.

Los deformadores funcionan al crear un rig con ellos como padres del dibujo que desee deformar, crear una
estructura de deformador y, a continuacién, animarlo. Se puede realizar facilmente con la herramienta Rigging
iT.

Hay dos tipos de deformadores disponibles en Harmony Essentials:
e Hueso

o Hueso para juego

NOTA

Harmony Premium también admite los deformadores de curva y de distorsién de envolvente, que
ofrecen funciones de deformacién ampliadas que no son compatibles con Harmony Essentials.

Deformador de huesos

La deformacién de hueso permite crear una estructura similar al hueso en la que cada parte es sdlida, pero las
articulaciones son flexibles. Esto es sobre todo (til para la animacidn de los miembros de un personaje, como los
brazos o las piernas, u otras partes que se puedan articular, como torsos o dedos. Por ejemplo, se puede utilizar
una deformacién de hueso para articular un brazo que estd hecho de un solo dibujo, de modo que el brazo vy el
antebrazo se puedan mover de forma independiente, sin necesidad de dibujar la parte superior del brazoy el
antebrazo en capas diferentes. Harmony deformara el dibujo para que parezca que estd articulado. Las
distintas partes de una deformacidn de hueso se pueden rotar alrededor de su articulacidn, extenderse y
acortarse, proporcionandole las mismas capacidades que las articulaciones de animacidn en distintas capas, sin
tener que preocuparse por la separacion de piezas, puntos de pivote o recorte de contornos.
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== Hueso

. = Articulacién incluida

o
Huesg ==

Deformador de hueso para juego

La deformacién de hueso para juego es parecida a la deformacion de hueso. Permite crear una estructura similar
al hueso en la que cada parte es sélida, pero las articulaciones son flexibles. Sin embargo, se optimiza para
motores de juego como Unity. Por lo tanto, generalmente se usa para desarrollo de juegos y no en producciones
animadas. A diferencia de las deformaciones de hueso, las deformaciones de hueso para juego no tienen una
propiedad de sesgo. Los pliegues de la articulacién también parecen ligeramente mas redondos.

== Hueso

4 = Aticulaciénincluida

Lt

Hueso ==

Creacion de deformadores

La manera mas sencilla para crear deformadores es usar la herramienta Rigging {T, disponible en la barra de
herramientas Deformation (Deformacidn). Con esta herramienta, todo lo que necesita hacer para crear un
deformador es seleccionar la capa que desee deformar vy, a continuacion, colocar cada punto del deformador en

la vista de camara.
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Los deformadores existen en la escena como una jerarquia de capas de deformacién. Cuando crea un nuevo
deformador, el primer punto que define es la raiz del deformador y cada punto nuevo que crea es un hijo del
punto anterior. Por lo tanto, los deformadores se crean en una cadena y se deben crear teniendo en cuenta la
jerarguia del personaje. Por ejemplo, si crea un deformador para un brazo, la raiz debe ser la articulacion del
hombro, el segundo punto debe ser el codo y el tercero, la muneca.

Seleccidén del elemento en el que crear un deformador

Un deformador afecta a todas las capas que hay debajo de su jerarquia. Al crear un nuevo deformador
utilizando la herramienta rigging, se crea automaticamente como padre de la capa seleccionada, y afectard
a la capa seleccionada y a todas sus hijas. Por lo tanto, es importante seleccionar la capa correcta antes de
intentar crear un deformador.

Por ejemplo, si se desea crear un deformador para un brazoy el brazo se divide en varias capas, se puede
crear un rig del brazo en una jerarquia donde el brazo superior sea la raiz, el antebrazo sea el hijo del brazo
superior y la mano sea el hijo del antebrazo. A continuacidn, si crea su deformador en la parte superior del
brazo, se creard como padre de la parte superior del brazoy, por lo tanto, afectara a todo el brazo.

También puede agrupar varias capas debajo de un peg y crear su deformador con este peg seleccionado. Al
crear un deformador en un peg, el deformador se crea como un hijo del peg, pero como padre de todos los
hijos de este peg. Esto se debe a que es probable que un peg sea mas Util sobre un deformador que debajo.
Si mueve las capas que estdn debajo un deformador, saldrdn de la zona de deformacion prevista y pueden
aparecer muy deformadas y distorsionadas. Por lo tanto, es mejor crear todas las deformaciones posibles
debajo de los pegs, y los pegs que estén debajo de los deformadores solo deben animarse si el deformador
se queda intacto. Dado que el deformador se creara como padre de todos los hijos del peg, afectard a todas
las capas que haya debajo de este.

Creacion de un deformador de hueso o de hueso para juego

1. Una vez seleccionado el elemento, seleccione la herramienta Rigging 1T en la barra de
herramientas Deformation (Deformacidn).
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2. En lavista de propiedades de la herramienta, habilite el modo Bone (Hueso) 4 o el modo Game
Bone (Hueso para juego) & dependiendo de si el rigging es para un proyecto de animacion o para
un juego.

3. Cologue el cursor en la raiz del dibujo o de la jerarquia de dibujo, haga clic una vez y suéltelo. Por
ejemplo, si va a crear un deformador para todo el brazo, haga clic en la articulacién del hombro.

L TN

4. Mueva el cursor en la ubicacidn en la que desee que termine el primer hueso y que comience el
segundo hueso, y haga clic de nuevo. Se insertard automaticamente un punto de control de
articulacién entre cada hueso que cree.

5. Mueva el cursor donde desee que se situe la siguiente articulacién y haga clic para crear el siguiente
punto.

Observe que, al crear un nuevo punto, el anterior aparece ahora rodeado por un circulo. Se trata del
radio de la articulacién, lo que permite determinar qué cantidad de dibujo debe formar parte de la
articulacién. Cada punto de un deformador de hueso, a excepcidn del primero y del dltimo, cuenta
con un punto de ajuste de radio.

6. Haga clicy mantenga pulsado el manipulador del radio de la articulacién anterior y ajuste el radio de
la articulacion de modo que cubra el miembro.
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7. Repita el proceso hasta que haya terminado de crear la cadena de huesos. Aseglrese de crear cada
articulacién en el orden correcto desde la raiz hasta la extremidad.

Visualizacién de deformadores

Harmony permite controlar qué deformadores se muestran en la vista de cdmara independientemente de la
seleccidn actual. Al crear una cadena de deformacion, sus controles de deformacién se muestran en la vista de
camara. Sin embargo, si selecciona un deformador existente o una capa que esté conectada a deformadores
existentes, sus controles de deformacién no se mostrardn inmediatamente. Asimismo, al desactivar una cadena
de deformacién no se ocultardn sus controles de deformacién. Para poder animar o modificar una cadena de
deformacién existente, debe mostrarla de forma manual.

Visualizacion de los controles de deformacion

1. Realice una de las siguientes acciones:

« Enlavista de cdmara o de linea de tiempo, seleccione uno de los elementos de dibujo
vinculados a la cadena de deformacién que desee visualizar.

« Enlavista de linea de tiempo, seleccione cualquier parte de la cadena de deformacién
que desee visualizar.

2. Enla barra de herramientas Deformation (Deformacidn), haga clic en el botén Show the Selected
Deformation Chain and Hide All Others (Mostrar la cadena de deformacién seleccionada y ocultar el
resto) < .

Los controles de deformacién seleccionados aparecen en la vista de cdmara y los demds quedan
ocultos.

NOTA

El botdn Show the Selected Deformation Chain and Hide All Others (Mostrar la cadena de
deformacién seleccionada y ocultar el resto) mostrard todas las cadenas de deformaciéon que se
encuentran en la jerarquia de la seleccidn. Por ejemplo, si estd seleccionado el peg maestro de
un modelo de personaje, se mostraran todas sus cadenas de deformacién. Asimismo, si estan
seleccionadas varias capas vinculadas con distintas cadenas de deformacién, se mostraran
todas sus cadenas de deformacion.
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Cémo ocultar los controles de deformacién

1. Realice una de las siguientes acciones:

o Enlabarrade herramientas Camera (Camara), haga clic en el botén Hide All Controls
(Ocultar todos los controles)

o En el menu superior, seleccione View > Hide All Controls (Ver > Ocultar todos los
controles).

o Pulse Mayls + C.

« Seleccione una capa que no esté vinculada a ningun deformador y haga clic en el botén
Show the Selected Deformation Chain and Hide All Others (Mostrar la cadena de
deformacidn seleccionada y ocultar el resto) <.

Modificacidn de las cadenas de deformacion existentes

A medida que intenta animar una deformacidn, o si necesita realizar cambios en los dibujos de una deformacidn,
es posible que deba realizar ajustes en la cadena de deformacién para que se adapte mejor a sus necesidades.

Adicion de una articulacion a una deformacién de hueso o de hueso para juego
existente

1. Seleccione la capa de dibujo o la cadena de deformacién a la que desea agregar una articulacion.

2. Enlabarra de herramientas Deformation (Deformacién), haga clic en el botén Show the Selected
Deformation Chain and Hide All Others (Mostrar la cadena de deformacién seleccionada y ocultar el
resto) © para mostrar los controles de deformacidn en la vista de cdmara. De este modo, también se
ocultan todos los controles de deformacidn visualizados.

3. Seleccione la herramienta Rigging 1T .

La cadena de deformacién cambia de verde a rojo. Una cadena verde indica que estad animando la
deformacién. Una cadena roja indica que esta modificando el rig.

4. Mueva el cursor sobre el segmento de hueso donde desea agregar una articulacién.

5. Mantenga pulsada la tecla Alt y haga clic.

& B
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Realizacion de ajustes en los deformadores existentes

1. Seleccione la capa de dibujo o la cadena de deformacidn para la que necesita realizar ajustes.

2. En la barra de herramientas Deformation (Deformacién), haga clic en el botén Show the Selected
Deformation Chain and Hide All Others (Mostrar la cadena de deformacién seleccionada y ocultar el
resto) ¢ para mostrar los controles de deformacidn en la vista de cdmara. De este modo, también se
ocultan todos los controles de deformacidn visualizados.

3. Enlabarra de herramientas Deformation (Deformacidn), haga clic en la herramienta Rigging T .

La cadena de deformacién cambia de verde a rojo. Una cadena verde indica que estd animando la
deformacién. Una cadena roja indica que estd modificando el rig.

Ao

4. En lavista de cdmara, configure la cadena de deformacion.

« Gire el primer hueso para cambiar el dngulo de la cadena.

Il

« Utilice el control raiz para cambiar de posicion (desplazar) toda la cadena.
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« Utilice puntos de control para cambiar de posicidn las articulaciones. De este modo se
alargard, acortard o cambiard la direccién del hueso. Esto también desplazard los
demds puntos de la cadena de deformacion.

}

« Utilice el control de la articulacién (cuadrado) para cambiar el tamafo de la misma. Por
motivos de calidad, se recomienda que el didmetro de la articulacién se ajuste al de la
parte que controla.
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5. Repita el proceso hasta que todas las articulaciones y huesos de la cadena estén correctamente
alineados con el elemento con el que estan vinculados.

NOTA

Al manipular la articulacién de un hueso o hueso para juego, puede mantener pulsada la tecla
Alt para bloquear el dngulo del hueso y solo acortar o alargar el hueso. También puede
mantener pulsada la tecla Ctrl (Windows/Linux) o &8 (macOS) para romper la articulacién de su
cadena y transformarla en una nueva cadena de deformador independiente.

Animacion con deformadores

Aligual que con los pegs de animacidn y las capas de dibujo, puede animar los deformadores creando
fotogramas clave en sus capas correspondientes en la linea de tiempo. La animacién de deformadores funciona
exactamente igual que la realizacién de modificaciones en un deformador, excepto que requiere el uso de la
herramienta Transform (Transformar) i en lugar de la herramienta Rigging. Al seleccionar la herramienta
Transform (Transformar), los controles de deformacién de la vista de cdmara se muestran de color verde, lo que
significa que se encuentran en modo de animacién, mientras que cuando se selecciona la herramienta Rigging,
se muestran en rojo, lo que significa que se encuentran en modo de rigging.

Animacion de deformaciones de hueso y hueso para juego
1. En lavista de linea de tiempo, contraiga el personaje con la flecha Expand/Collapse
(Expandir/Contraer).

o | |

o ||

2. Seleccione el primer fotograma de la escena.
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3. Paragarantizar que el modelo no desaparezca después de 1 fotograma, abra el cuadro de didlogo
Extend Exposure (Extender exposicidn) realizando una de las siguientes acciones:

« Haga clic con el botén derecho en el primer fotograma de la vista de linea de tiempo y
seleccione Extend Exposure (Extender exposicién).

e Pulse F5.

4. En el cuadro de didlogo Extend Exposure (Extender exposicidn), escriba el nimero de fotogramas de
la escena y confirme. De este modo, el modelo quedard expuesto (serd visible) en toda la escena.

5. Ahora crearemos la primera pose del personaje. En primer lugar, asegurese de que haya un
fotograma clave en el primer fotograma de cada capa del modelo. Con ello garantiza que cuando
cree la segunda pose mds tarde, la primera pose no se vea afectada. Para llevarlo a cabo, realice una
de las siguientes acciones:

o Enlabarrade herramientas Timeline (Linea de tiempo), haga clicen el botén Add
Keyframe (Agregar fotograma clave) * .

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.

Se agrega un fotograma clave al fotograma actual.

ro=al
o L]

o ||

6. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Transform
(Transformar) i o pulse Mayus + T.

7. Enlabarra de herramientas Tools (Herramientas), active el modo Animate (Animar) < . Esto
permite que la herramienta Transform (Transformar) afecte a la posicidén y al tamafio de una capa
solo en el fotograma clave actual, mientras que, en caso contrario, afectaria a la posicién y al tamafio
de la capa en toda la escena.

8. Realice una de las siguientes acciones:

« Enlavista de cdmara o de linea de tiempo, seleccione uno de los elementos de dibujo
vinculados a la cadena de deformacién que desee visualizar.

« Enlavista de linea de tiempo, seleccione cualquier parte de la cadena de deformacién
que desee visualizar.
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10.

En la barra de herramientas Deformation (Deformacién), haga clic en el botén Show the Selected
Deformation Chain and Hide All Others (Mostrar la cadena de deformacién seleccionada y ocultar el
resto) < .

Los controles de deformacién seleccionados aparecen en la vista de cdmara y los demds quedan
ocultos.

En la vista de cdmara, realice lo siguiente:

o Gire el primer hueso para rotar el miembro.

« Girelos demds huesos para doblar el miembro.

o Utilice el control raiz para cambiar de posicién (desplazar) toda la cadena.
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« Utilice puntos de control para cambiar de posicidn las articulaciones. De este modo se
alargard, acortara o cambiard la direccién del hueso, y se desplazardn los demas hijos.

AW

11. Enlavista de linea de tiempo, vaya al fotograma en el que desee definir la siguiente pose clave.
12. Agregue un fotograma clave en el fotograma actual realizando una de las siguientes acciones:

o Enlabarrade herramientas Timeline (Linea de tiempo), haga clic en el botén Add

Keyframe (Agregar fotograma clave) * .
« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.
13. Transforme los puntos de la cadena de deformacidn para crear la nueva pose clave.

14. Repita los pasos anteriores hasta que la animacion haya terminado.

NOTA

Al manipular la articulacién de un hueso o hueso para juego, puede mantener pulsada la tecla
Alt para bloquear el angulo del hueso y solo acortar o alargar el hueso. También puede
mantener pulsada la tecla Ctrl (Windows/Linux) o 3§ (macOS) para romper la articulacién de su
cadena y transformarla en una nueva cadena de deformador independiente.
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Capitulo 14: Importacion de sonido y sincronizacion
de labios

e W
~ \

Importacion de sonido

Si desea agregar sonido a la animacidn, se recomienda que edite y mezcle los archivos de sonido en un software
de edicién de sonido. Tener pistas de sonido completamente premezcladas garantiza que el sonido conserve su
tiempo, mezcla y calidad si utiliza software de terceros para la postproduccidn. Otra buena practica es mantener
la pista de sonido separada en pistas de mdsica, efectos de sonido y personajes para facilitar la sincronizacién
de la animacidn con voces y sonidos. De lo contrario, es posible recortar los efectos de sonido y ajustar su
volumen directamente en Harmony cuando sea necesario.

Si crea el proyecto en Toon Boom Storyboard Pro, puede exportar todas las escenas del proyecto como escenas
separadas de Harmony. La pista de sonido del storyboard se cortard por escenay cada pieza se insertard en las
escenas exportadas, lo que le permite ahorrar tiempo en la divisién e importacidn de la pista de sonido.

Harmony puede importar archivos de sonido .wav, .aiff y . mp3.

NOTA

La importacién de una pista de sonido mds larga que la escena no ampliard la longitud de esta
dltima. La reproduccién de sonido se detendr3 al final de la duracién de la escena.

Importacién de un archivo de sonido

1. Realice una de las siguientes acciones:
« En el menu superior, seleccione File > Import > Sound (Archivo > Importar > Sonido).

« Enlavista de carta de rodaje, haga clic con el botén derecho en cualquier parte del
drea de fotogramas y seleccione Import > Sounds (Importar > Sonidos).

Se abre el cuadro de didlogo Select Sound File (Seleccionar archivo de sonido).

2. En el cuadro de didlogo Select Sound File (Seleccionar archivo de sonido), busque y seleccione un
archivo de sonido.

El archivo de sonido aparece como una capa en la vista de linea de tiempo. Su forma de onda se
muestra en la pista para ayudar a visualizar en qué fotogramas se producen los efectos de sonido de
la pista de sonido.
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La pista de sonido también aparece como una columna en la vista de carta de rodaje, pero no
mostrara una forma de onda de forma predeterminada. Si lo desea, puede visualizar la forma de
onda de una columna de sonido haciendo clic con el botdn derecho en ella y seleccionando Sound
Display > Waveform (Visualizacién de sonido > Forma de onda).

|

Deteccion automatica de sincronizacion de labios

La adicidn de la sincronizacion de labios a la animacién es fundamental para que parezca que los personajes
estdn vivos. Sin embargo, también es una parte especialmente pesada del proceso de animacion.

e W
~ \

Para solucionar este problema, Harmony proporciona una funcién de deteccién automatica de sincronizacion de
labios. Esta funcién analiza el contenido de una pista de sonido de la escena y asocia cada fonema que detecta
con una de las formas de boca de la siguiente carta de fonemas, que es una carta de fonemas estdndar del
sector de la animacion.

4/ /\ - /i 5 ?/ N
b \
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(
Boca
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NOTA

Las letras asignadas a estas formas de boca son identificadores estdandar y NO se corresponden con
el sonido que se pretende producir.

Esta es una aproximacion de los fonemas ingleses que cada forma de boca puede utilizar para representar:
e« A:m,b,p,h
« B:s,d,j ikt
e Ce,a
« D:AE
« Eo
e F:u,00
o« G:f ph
« X:silencio, sonido indeterminado

Al realizar la deteccién automatica de sincronizacién de labios, Harmony no crea dibujos de boca. Simplemente
rellena la columna de dibujo de la capa de la boca del personaje con la sincronizacién de labios generada,
insertando la letra asociada con la forma de boca correcta en cada celda de la columna. Por lo tanto, para que la
deteccién automatica de sincronizacion de labios funcione, la capa de la boca del personaje ya debe contener un
dibujo de boca para cada dibujo de la carta de fonemas, y estos dibujos deben tener el nombre de su letra
correspondiente.

Generacion de una deteccidon de sonido para sincronizacion de labios mediante la vista
de propiedades de capa

1. En lavista de linea de tiempo o de carta de rodaje, seleccione la capa de sonido.
Las opciones para dicha capa aparecerdn en la vista de propiedades de capa.

2. Enlas propiedades de capa, haga clic en Detect (Detectar).
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Harmony analiza los clips de sonido seleccionados y asigna una letra de sincronizacion de labios a
cada celda de sonido.

3. Hagaclicen el botén Map (Asignar) para abrir el cuadro de didlogo Lip-Sync Mapping (Asignacion
de sincronizacién de labios).

4. En el menu Destination Layer (Capa de destino), seleccione la capa que contiene las posiciones de la
boca para la pista de voz del personaje.
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NOTA

Si la capa seleccionada contiene simbolos, puede asignar la sincronizacion de labios
utilizando dibujos situados directamente en la capa o bien utilizar los fotogramas del
simbolo. En el campo Symbol Layer (Capa de simbolos), seleccione Don't Use Any
Symbol (No usar ninguin simbolo) si desea utilizar los dibujos o seleccionar el simbolo
deseado del menu desplegable.

5. En la seccién Mapping (Asignacién), escriba el nombre del dibujo o los fotogramas del simbolo en el
campo situado a la derecha del fonema que representa. Si los dibujos ya tienen los nombres de las
letras del fonema, puede saltarse este paso.

6. Hagaclicen OK (Aceptar).

7. Enlabarra de herramientas Playback (Reproducir), habilite la opcién Enable Sound (Habilitar
sonido) <.

8. Pulse el botdn Play (Reproducir) » en la barra de herramientas Playback (Reproducir) para ver y oir
los resultados en la vista de cdmara.

Si tiene que realizar ajustes a la sincronizacién de labios generada automaticamente, consulte
Animacién manual de sincronizacidn de labios en la pagina 100.

Animacion manual de sincronizacidn de labios

Puede crear la sincronizacion de labios para la escena de forma manual seleccionando qué dibujo de boca debe
exponerse en cada fotograma del cuadro del didlogo de su personaje. Para este proceso, utilizard la funcién
Sound Scrubbing (Depuracién de sonido), que reproduce la parte de la pista de sonido en el fotograma actual
cada vez que mueva el cursor de la linea de tiempo, lo que le permite identificar los fonemas que debe hacer
coincidir con la boca de su personaje. También se utilizara un dibujo de sustitucién para cambiar el dibujo de la
boca gue se expone en cada fotograma.

Animacion de sincronizacion de labios utilizando la vista de linea de tiempo

1. Enlabarrade herramientas Playback (Reproducir), haga clic en el botén Sound Scrubbing
(Depuracion de sonido) <s.

2. Enlavista delinea de tiempo, arrastre el cabezal de reproduccién rojo a lo largo de la forma de onda
de la capa de sonido.

3. Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en la
capa de formas de boca.
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4.

5

En la seccién Parameters (Pardmetros), y continuando en la capa de formas de boca, coloque el
cursor en la parte superior del nombre del dibujo (hormalmente una letra) hasta que cambie al
puntero de intercambio .

Arrastre el cursor para ver la lista de los nombres de la forma de la boca y elija la que desee. El dibujo
actual se cambia automaticamente a la nueva seleccién.

Animacion de sincronizacion de labios utilizando la vista de libreria

1.

En la barra de herramientas Playback (Reproducir), haga clic el botén Sound Scrubbing (Depuracién
de sonido) «s.

En la vista de linea de tiempo, arrastre el cabezal de reproduccidn rojo a lo largo de la forma de onda
de la capa de sonido.

Cuando llegue a un fotograma en el que deba ir una posicién determinada de la boca, por ejemplo,
una boca abierta con labios redondeados para un sonido como "oh", haga clic en ese fotograma en Ila
capa de formas de boca.

En la ventana Drawing Substitution (Sustitucidn de dibujo) de la vista de libreria, arrastre el control
para elegir una forma de boca. El dibujo actual se intercambia por el de la ventana de
previsualizacién.
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Capitulo 15: Adicion de efectos a una escena

Al crear una escena, crear un rig de personaje o una vez que la animacion esté terminada, puede agregar
efectos, como desenfoques, brillos, sobras, filtros de color y de transparencia, asi como mejorar la calidad del
proyecto. Los efectos cambian la forma en la que las capas o grupos de capas se renderizan en la escena.

Acerca de los efectos

Los efectos son tipos de capas especiales que se pueden agregar a la estructura de la escena. Para que una capa
de efecto funcione, debe estar conectada como hija de un dibujo, grupo u otro efecto. Los efectos solo se aplican
al elemento al que estdn conectados. Esto proporciona flexibilidad a la hora de decidir a qué elementos de la
escena afecta un efecto.

Algunos efectos necesitan vincularse a otra capa, denominada capa de mate, que se usa para definir el drea a la
que deben afectar. El ejemplo mds bdsico es el efecto de cuchilla. Por si solo, un efecto de cuchilla no tienen
ningun impacto en el dibujo al que estd conectado. Una vez combinado con una capa de mate, el efecto de
cuchilla corta la forma del mate fuera del dibujo.
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Una capa de mate es una capa de dibujo habitual que estd conectada a un efecto como su mate. El efecto toma
la forma del dibujo en la capa de mate e ignora sus colores y detalles para determinar el drea de laimagen ala
que debe afectar.

En la vista de linea de tiempo, se debe crear un rig de un efecto como el hijo de una capa de dibujo o grupo al
que debe afectar. Si el efecto puede usar una capa de mate, tendrd un pardmetro de mate al ampliar la lista de
parametros. Puede arrastrar y colocar la capa en la que desee usar un mate para el efecto en el pardmetro de
mate del efecto para vincularlos.

Una vez que el efecto estd conectado, puede ajustar sus parametros en la vista de propiedades de capa. Si se
desea, incluso puede animar los pardmetros del efecto convirtiendo sus valores a funciones.

Adicion de un efecto

En Harmony, puede agregar efectos seleccionando la capa o grupo al que desee agregar un efectoy, a
continuacidn, agregando el efecto a través del menud Add Layers (Agregar capas) de la vista de linea de tiempo.
A continuacidn, puede conseguir el efecto previsto ajustando los pardmetros en la vista de propiedades de capa
y conectandolos a una capa de mate, segun proceda.

Adicion de efectos en la vista de linea de tiempo

1. Enlavista de linea de tiempo, seleccione la capa en la que desee agregar un efecto.
2. Realice una de las siguientes acciones:
« En el menu superior, seleccione Insert > Effects > effect (Insertar > Efectos > efecto).

« Enlabarrade herramientas Layers (Capas), haga clic en el botén Add Layers (Agregar
capas) y seleccione Effects > effect (Efectos > efecto).

« Haga clic con el botén derecho en la capay, a continuacidn, seleccione Insert > Effects
> effect (Insertar > Efectos > efecto).

El efecto aparece en la vista de linea de tiempo.

3. Enlavista de cdmara, haga clic en el botén Render View (Vista de render) 4 para ver el fotograma
y el efecto actuales renderizados de la escena. Tenga en cuenta que la mayorfa de los efectos no se
pueden reproducir en tiempo real. Debe usar la opcién Render and Play (Renderizar y reproducir) &=
de la barra de herramientas Playback (Reproducir).
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NOTA

El fondo aparecerd en negro de forma predeterminada. Para corregirlo, puede
agregar una capa de la carta de color en la parte inferior de la lista de capasy
cambiar su color en la vista de propiedades de capa.

4. En lavistadelinea de tiempo, haga doble clic en la capa del efecto para abrir la ventana Layer
Properties (Propiedades de capa). También puede seleccionar la capa del efecto y ver sus
propiedades en la vista de propiedades de capa.

Se abre la vista de propiedades de capa y muestra los pardmetros disponibles para el efecto
seleccionado.

5. Enlavista de propiedades de capa, ajuste los parametros del efecto segun sea necesario. Cada vez
gue realice un cambio, la vista de cdmara tendrd que actualizar el render, lo cual puede provocar una
ligera demora antes de que pueda observar el efecto.

6. Parareproducir la escena con los efectos finales, haga clic en el botén Render and Play (Renderizar
y reproducir) B en la barra de herramientas Playblack (Reproducir).

NOTA

Una vez que haya establecido los pardmetros para el efecto, puede almacenarlo en la vista de
libreria como plantilla para poder reutilizarlo rdpidamente sin necesidad de restablecer los
pardametros de nuevo; consulte Creacion y uso de plantillas en la pagina 122.

Uso del efecto de cuchilla
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El efecto de cuchilla permite cortar una parte de una imagen. Para ello, debe conectarse al dibujo que se
pretende cortar, asi como a una capa de mate. La cuchilla adoptara la forma del dibujo de la capa de matey
cortard esta forma de la capa de dibujo. Esto es especialmente Util si desea que un personaje desaparezca entre
un elemento de fondo o si desea realizar un agujero en el centro de un personaje.

Al igual que todos los efectos que utilizan un mate, el efecto de cuchilla tiene un pardmetro Inverted (Invertido),
que esta deshabilitado de forma predeterminada. Cuando esté habilitada, la cuchilla tendra el efecto contrario:
en lugar de cortar la forma del mate del dibujo, cortara todo lo que se encuentre fuera de |la forma del mate del
dibujo, dejando solo las partes del dibujo que estén cubiertas por el mate. Esto puede ser (til si, por ejemplo,
desea dibujar sombras o resaltados para un personaje, pero no desea tener que preocuparse de que abarquen
mas alld del contorno del personaje. Simplemente puede conectar la sombra o el resaltado a una cuchilla
invertida y utilizar un clon del personaje como el mate, y el efecto no se mostrara fuera de los contornos del
personaje.

ro=al

Uso del efecto de cuchilla

1. Seleccione una capa de dibujo.

2. Hagaclicen el botén Add Layers (Agregar capas) y seleccione Effects > Cutter (Efectos >
Cuchilla).

El efecto de cuchilla se crea como capa hija de la capa seleccionada.

3. Enlavistadelinea de tiempo, cree una nueva capa, que se utilizard como la capa de mate del efecto
de cuchilla.

4. Enlanueva capa de mate, dibuje la forma que desee cortar de la capa de dibujo.

5. Enlavista de linea de tiempo, haga clic en el botdn Collapse/Expand (Contraer/expandir) dela
capa del efecto para mostrar su pardmetro de mate.

6. Arrastrey coloque la capa de mate junto al campo Matte (Mate) de la capa de Cutter (Cuchilla),
debajo de la columna Parameters (Pardmetros).
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7. Sidesea invertir el efecto de cuchilla, haga doble clic en la capa Cutter (Cuchilla) para abrir el cuadro
de didlogo Layer Properties (Propiedades de capa) y, a continuacién, habilite la opcidén Inverted
(Invertido).

NOTA

Si solo necesita aplicar un mate a una sola capa de dibujo, puede vincular este mate a la propia
conexién de mate de la capa de dibujo. Cada capa de dibujo tiene su propia conexién de mate,
que puede actuar como una cuchilla individual si estd conectada a otra capa de dibujo.

Animacion de un efecto

En algunos casos, puede que desee tener la intensidad, el color u otro pardmetro de un efecto animado. Por
ejemplo, puede que aplicar un fundido de entrada o de salida a un objeto. Para llevarlo a cabo, tendria que
conectarlo a un efecto de transparencia y animar el nivel de transparencia del efecto, de modo que aumente o
disminuya al reproducir la escena. Puede animar el pardmetro de un efecto creando una curva de funcidn para
dicho pardmetro. A continuacién, puede agregar fotogramas clave a la funcién y definirlos en distintos valores,
consiguiendo asi que el pardmetro del efecto cambie el valor progresivamente al reproducir la escena. A fin de
crear una funcién para el parametro de un efecto, tendrd que usar la vista de propiedades de capa.

Animacion de un efecto
1. Enlavista de linea de tiempo, seleccione una capay agréguele un efecto realizando una de las

siguientes acciones:

« Hagaclicen el botén Add Layer (Agregar capa) y seleccione Effects > desired
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effect (Efectos > efecto deseado).

« Haca clic con el botdn derecho y seleccione Insert > Effects > desired effect (Insertar >
Efectos > efecto deseado).

« En el menu superior, seleccione Insert > Effects > desired effect (Insertar > Efectos >
efecto deseado).

2. Cree la curva de funcidn realizando una de las siguientes acciones:

o Haga doble clic en la capa de efecto para mostrar las propiedades del mismo. Haga clic
en el botén Function (Funcién) -+ del pardmetro que desee animar y cree una curva de
funcién.

« En lavista de linea de tiempo, expanda los pardmetros de la capa del efecto haciendo

clicen el botén Collapse/Expand (Contraer/expandir) =/~. A continuacidn, haga clicen
el botén Function (Funcién) -+ del pardmetro que desee animar y cree una curva de
funcién.
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3. Enlavistadelinea de tiempo, vaya al fotograma en el que desea comenzar a animar el efecto.

4. En labarra de herramientas Timeline (Linea de tiempo), agregue un fotograma clave a la funcién
realizando una de las siguientes acciones:

« Enlabarrade herramientas Timeline (Linea de tiempo), haga clic en el botén Add
Keyframe (Agregar fotograma clave) * .

« Haga clic con el botén derecho y seleccione Add Keyframe (Agregar fotograma clave).
o Pulse F6.

5. En el campo Value (Valor) del pardmetro que desee animar, introduzca el valor que desee que tenga
el pardmetro en este fotograma clave.

6. Repita estos pasos hasta que haya terminado la animacién del efecto.

Creacion de un efecto basado en un personaje animado

En el siguiente tutorial se demuestra cdmo combinar efectos con otras funciones de Harmony para crear
facilmente una sombra paralela para un personaje animado. Siguiendo estos pasos, puede crear una sombra
paralela que seguird automaticamente la animacién del personaje, incluso si después cambia la animacion.

Creacién de una sombra paralela para un personaje animado

1. Enlavista de linea de tiempo, seleccione todas las capas que forman el rig de personaje. Si el
personaje estd bajo un peg maestro, también funcionar3d si selecciona el peg maestro.
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2. Asegurese de que el rig de personaje se encuentre en un grupo. De no ser asf, haga clic con el botdn
derecho en la seleccidn vy, a continuacidn, seleccione Group Selection (Seleccién de grupo).

3. Una vez seleccionado el personaje en la vista de linea de tiempo, cree un clon del personaje
realizando una de las siguientes acciones:

« Haga clic con el botén derecho en la seleccién vy, a continuacidn, seleccione Clone
Selected Layers: Drawings and Timing (Clonar capas seleccionadas: Dibujos y tiempo).

« En el menu superior, seleccione Edit > Clone: Drawings and Timing
(Editar > Clonar: Dibujos y tiempo).

rno=am

NOTA

Al contrario que un duplicado, una capa clonada siempre tiene el mismo tiempoy la
misma exposicién que su capa de origen, incluso si su capa de origen se cambia mas
tarde. Por lo tanto, puede cambiar la animacién del personaje y la animacién del
personaje clonado se actualizard automaticamente con estos cambios.

4. Agregue un efecto de sombra al grupo realizando una de las siguientes acciones.

« Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clicen Add
Layers (Agregar capas) y seleccione Effects > Shadow (Efectos > Sombra).
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« Haga clic con el botén derecho en la seleccidn vy, a continuacidn, seleccione Insert >
Effects > Shadow (Insertar > Efectos > Sombra).

5. En lavista de linea de tiempo, seleccione la capa raiz del clon del personaje.
6. Cree un peg padre para el clon realizando una de las siguientes acciones:

« Enlabarrade herramientas de capas de la vista de linea de tiempo, haga clicen el
botén Add Peg (Agregar peg) = .

o Pulse Ctrl + P (Windows/Linux) o 38 + P (macOS).

7. Enlavista delinea de tiempo, seleccione el peg padre del clon.

8. En la barra de herramientas Tools (Herramientas), seleccione la herramienta Transform
(Transformar) i:.

9. Enlavista de cdmara, escale y sesgue el clon de modo que parezca una sombra difuminada.
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Capitulo 16: Uso de guias de dibujo

Cuando tenga que dibujar fondos u objetos con numerosas lineas rectas, dngulos en escuadra y perspectivas,
puede usar las guias de dibujo para que le ayuden. Las guias agregan una linea de horizonte, asi como puntos
de fuga al espacio del dibujo, que se pueden mover para adaptar las necesidades de la escena y bloquean las
herramientas de dibujo para que siempre dibujen lineas rectas, bien desde uno de los puntos de fuga, o bien

hacia el eje horizontal o vertical de la gufa.
Harmony admite los siguientes tipos de gufas de dibujo:

« Una guia de Cuadricula cuadrada simplemente le ayuda a dibujar en los ejes horizontales y verticales,

que son relativos a la linea del horizonte.

« Una guia de Perspectiva con 1 punto le ayuda a dibujar lineas procedentes de un unico punto de fuga,
que se sitla en el centro del horizonte de forma predeterminada. También le ayuda a dibujar a lo largo de
los ejes horizontales y verticales. Esto puede ayudar a crear fondos realistas con edificios, paredesy

objetos situados enfrente de la cdmara.

o Una guia de Perspectiva con 2 puntos le ayuda a dibujar lineas procedentes de uno de los dos puntos de
fuga situados a laizquierda y a la derecha del espacio de dibujo. Esto puede ayudar a crear fondos
realistas con edificios, paredesy objetos situados en un dngulo de la cdmara.
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« Una guia de Perspectiva con 3 puntos le ayuda a dibujar lineas procedentes de uno de los 3 puntos de
fuga: dos puntos de fuga horizontales situados a la izquierda y a la derecha del espacio de dibujo, y un
punto de fuga vertical situado debajo o encima del espacio de dibujo. Esto puede ayudarle a crear fondos
realistas desde un dngulo bajo o alto. La guia de perspectiva con 3 puntos tiene dos valores predefinidos:
el plano cenital y el plano nadir, que se pueden utilizar para perspectivas de angulo alto y de dngulo bajo,

respectivamente.

Para usar una guia de dibujo, en primer lugar debe agregarla a la lista de guias de la escena.

Adicién de una guia de dibujo a la escena

1. En el menu superior, seleccione Windows > Guides (Ventanas > Guias) para agregar la vista de
guias al espacio de trabajo actual.

2. En lavista de gufas, seleccione el botén New Guide (Nueva gufa) y elija uno de los siguientes

tipos de guias:
. Cuadricula cuadrada
o I Perspectiva con 1 punto
« D+ Perspectiva con 2 puntos

. @ Perspectiva con 3 puntos (plano cenital)
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. é Perspectiva con 3 puntos (plano nadir)

La nueva guia aparece en la lista de la vista de gufas.

Number of Lines

3. Paraagregar otra guia, repita el paso anterior.

Edicion de una guia de dibujo

1. En lavista de linea de tiempo o de carta de rodaje, seleccione un dibujo o una celda vacia, y cree un
nuevo dibujo realizando una de las siguientes acciones:

« Haga clic con el botén derecho en la celda y seleccione Drawing > Create Empty Drawing
(Dibujo > Crear dibujo vacio).

o Pulse Alt + MayUus + R.

2. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel) &,
Pencil (L4piz) #, Stroke (Linea vectorial transparente) (-~ o Line (Linea) /.

3. Enlavista de guias, seleccione una guia para convertirla en la guia activa.

Una vez que la guia esté activa, su linea del horizonte y sus puntos de fuga aparecen en el drea de
dibujo.
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4. En lavista de guias, aseglrese de que la opcién Lock Guide (Bloquear gufa) [5» estd deshabilitada.
Con ello garantiza que puede editar la guia activa.

5. En el drea de dibujo, aleje el zoom hasta que todos los puntos de fuga sean visibles (si fuera
necesario).

6. En el drea de dibujo, agarre el horizonte o un punto de fuga y muévalo hasta la ubicacién deseada.

Al usar la guia de cuadricula cuadrada o la de perspectiva con 1 punto, el angulo del horizonte se
puede modificar al manipular la propia linea del horizonte.

Al usar la guia de perspectiva con 2 puntos o la de con 3 puntos, el angulo del horizonte se puede
modificar al manipular uno de los dos puntos de fuga del horizonte.
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Al ajustar la linea del horizonte, puede mantener pulsada la tecla MayUs para que la linea del
horizonte se ajuste a cada 15 grados. Asi es facil mantener un horizonte totalmente horizontal.

NOTA

Cada modificacidn a una gufa se puede deshacer con el comando Undo (Deshacer).

Dibujo con guias de dibujo

1. En lavista de linea de tiempo o de carta de rodaje, seleccione un dibujo o una celda vacia, y cree un
nuevo dibujo realizando una de las siguientes acciones:

« Haga clic con el botén derecho en la celda y seleccione Drawing > Create Empty Drawing
(Dibujo > Crear dibujo vacio).

o Pulse Alt + MayUus + R.

2. Enlabarrade herramientas Tools (Herramientas), seleccione la herramienta Brush (Pincel) &,
Pencil (L4piz) #, Stroke (Linea vectorial transparente) (-~ o Line (Linea) /.

3. Enlavista de guias, seleccione la guia que desee usar.

4. En el drea de dibujo, dibuje una linea vectorial transparente con la herramienta de dibujo actual.
Desde el gestoinicial, la herramienta se bloguea en uno de los ejes de la guia y lo fuerza a dibujar una
linea recta que siga al eje.
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Capitulo 17: Creaciéon de un multiplano

En la accidn en vivo, cuando la cdmara se mueva alrededor de una escena, parecerd que los objetos cercanos a la
camara se desplazan a una distancia mayor que los objetos alejados de la misma. En la animacién 2D, se puede

conseguir un efecto similar creando un multiplano.

En Harmony, puede configurar facilmente un multiplano creando un fondo sobre varias capas, extendiéndolas
en el eje Z para agregar profundidad y moviendo la cdmara por el entorno resultante para crear una ilusién de

perspectiva impresionante.

En el siguiente ejemplo, el fondo se compone de 6 capas diferentes y cada una representa un objeto que se
encuentra a una distancia diferente de la cdmara. A la izquierda, puede ver cémo se sitla cada objeto en
relacién con la cdmara, como si el espectador estuviera mirandolos desde un lado. A la derecha, puede ver cémo
se sitlan las capas unas respecto a otras, como si el espectador estuviera mirando la escena desde una esquina.
A continuacién, puede ver la escena desde el punto de vista de la cdmara.
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Mediante la herramienta Maintain Size (Mantener tamafo), puede convertir facilmente un fondo multicapa
normal en un multiplano. Esta herramienta permite mover una capa mas cerca o mas lejos de la cdmara mientras
se ajusta automdticamente el tamafio de la capa proporcionalmente a su distancia de la cdmara, conservando su
tamafo aparente desde el punto de vista de la cdmara. Por lo tanto, no tiene que preocuparse por el tamafio y
la posicidn de las capas al disefiar el fondo.

En una nueva escena de Harmony, dibuje los distintos elementos de un fondo en capas separadas. Siga los

pasos que se muestran a continuacion para convertir el fondo en un multiplano.

Configuracion de un multiplano con la herramienta Maintain Size (Mantener tamaio)

1. Realice una de las siguientes acciones:

« Enlabarrade herramientas Advanced Animation (Animacién avanzada), seleccione la
herramienta Maintain Size (Mantener tamano) &1 .

« En el menu superior, seleccione Animation > Tools > Maintain Size (Animacién >
Herramientas > Mantener tamano).

o Pulse Alt + 6.
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2. Enlavista lateral o superior, seleccione una de las capas de la seccién de imagenes miniatura.
También puede seleccionar una capa en la vista de linea de tiempo.

La capa seleccionada se resalta en las vistas superior, lateral y de cdmara.

El elemento se moverd en el eje Z de la escena, pero mantendrd el mismo tamafio aparente en la
vista de cdmara.
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Capitulo 18: Creacidon y uso de plantillas

Puede crear una plantilla a partir de una capa o de celdas. Puede almacenar como una plantilla cualquier
elemento disponible en la vista de linea de tiempo.

Creacion de una plantilla

Creacion de una plantilla

1. Enlavista de linea de tiempo, seleccione varias celdas o capas.

Puede crear una plantilla a partir de una jerarquia de capas entera contrayendo la jerarquia y
seleccionando su capa raiz. Esto puede ser (til para crear plantillas basadas en rigs de personajes o
fondos de escena.

2. Enlavista de librerfa, seleccione una carpeta para almacenar la plantilla. De forma predeterminada,
tendrd una libreria denominada Libreria de Harmony Essentials almacenada en el ordenador, en la
subcarpeta Librerfa de Toon Boom Harmony Essentials de la carpeta Documentos.

3. Silacarpeta de libreria esta bloqueada , haga clic con el botén derecho y seleccione Right to
Modify (Derecho para modificar).

4. Arrastre la seleccidn a la carpeta de la libreria elegida.

Library  ==[%

[ AW ]

5. En el cuadro de didlogo Rename (Cambiar nombre), asigne un nombre a la nueva plantilla.

6. Hagaclicen OK (Aceptar).
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NOTA

Si crea una plantilla seleccionando capas en la lista de capas de la vista de linea de tiempo, la
plantilla incluira la capa, asi como todos los dibujos que contenga, incluso los dibujos que no se
expongan en la linea de tiempo de la escena, mientras que la creacién de una plantilla mediante la
seleccién de celdas especificas en la linea de tiempo solo almacenard los dibujos seleccionados en la
plantilla.

NOTA

Para cambiar el nombre de una plantilla una vez creada, haga clic con el botén derecho en el
simbolo y seleccione Rename (Cambiar nombre).

Importacion de una plantilla
Importacién de una plantilla

1. Enlavista de libreria, seleccione la plantilla que desea importar.

2. Arrastre la plantilla seleccionada a la vista de cdmara o a la izquierda de la vista de linea de tiempo.

Si coloca la plantilla en la vista de cdmara, sus capas se agregardn en la parte superior de la lista de
capas. Si coloca una plantilla en la lista de capas de la vista de linea de tiempo, se insertard entre las
capas en las que la colocd.

Si la plantilla tiene la misma estructura de capas que una parte de la escena, puede colocarla
directamente en los fotogramas del lado derecho de la vista de linea de tiempo. En lugar de insertar
nuevas capas en la escena, esta accién reemplazarad los dibujos y los fotogramas clave de la escena
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por los de la plantilla. Esto es Util para importar plantillas de pose o animacién para los personajes
gue ya se encuentran en la escena.

Library | =%

[ATWI]

Timeline  ==[%
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Capitulo 19: Exportacion de una pelicula

Mediante el cuadro de didlogo Export Movie (Exportar pelicula), puede exportar la animacién como un archivo
de video. Harmony exportard toda la escena a resoluciéon completa de forma predeterminada. Si lo prefiere,
puede elegir exportar solo un rango de fotogramas especifico en la escena o exportarlo a menor resolucidn, lo
cual puede ser Util si necesita ahorrar tiempo o espacio en disco.

Si tiene requisitos especificos para la calidad y el tamafio de los archivos de video exportados, puede utilizar el
cuadro de didlogo Movie Options (Opciones de pelicula) para configurar la compresidn del video y del sonido. Si
va a exportar una pelicula de QuickTime, tiene acceso a todos los cédecs y configuraciones de compresién

disponibles en la interfaz de QuickTime.

NOTA

En Windows, puede exportar peliculas en formato Windows Media Video de forma
predeterminada o en formato de pelicula de QuickTime, si QuickTime estd instalado. En macOS y
Linux solo puede exportar en formato de pelicula de QuickTime.

Exportacién de un archivo de pelicula

1. En el mend superior, seleccione File > Export > Movie (Archivo > Exportar > Pelicula).

Se abre el cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime).

2. En el mentdesplegable Video Format (Formato de video), seleccione el formato deseado para el

archivo de pelicula:
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« Quick Time Movie (*.mov): Disponible de forma predeterminada en macOsy Linux, asf
como en Windows si QuickTime estd instalado.

o Windows Media Video (*.wmv): Disponible solamente en Windows. No es necesario
gue QuickTime esté instalado.

3. Haga clicen Browse (Examinar) para seleccionar la ubicaciéon y el nombre de archivo del archivo de
pelicula exportado.

4. Haga clicen OK (Aceptar).

5. Enla seccidn Export Range (Rango de exportacidn), decida si desea exportar toda la escena (All
(Todo)) o un intervalo de fotogramas especifico. Si decide lo Ultimo, introduzca un rango de
fotogramas.

6. Enla seccién Resolution (Resolucidn), seleccione una de las siguientes opciones en el menu:
o Una relacién de resolucién preferida.

o Custom (Personalizado): Activa los campos Width (Anchura) y Height (Altura) para
gue pueda introducir un tamafo especifico.

7. Enla seccién Options (Opciones), haga clic en Movie Options (Opciones de pelicula) para configurar
la compresién del video y del sonido de la pelicula.

Si el formato del video es Quick Time Movie, consulte las secciones Exportacion de una pelicula de

QuickTime sin pérdidas con transparencia en la pagina 128 y Configuracién de ajustes de video y

sonido para peliculas de QuickTime en la pagina 129. Si el formato del video es Windows Media

Video, consulte la seccién Configuracién de ajustes de video y sonido para Windows Media Video en

la pagina 132.

8. Hagaclicen OK (Aceptar).
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10.

En el cuadro de didlogo Export to QuickTime Movie (Exportar a pelicula de QuickTime), haga clicen
OK (Aceptar).

Aparece una barra de progreso.

Frame: 212

Stop

Desplacese a la ubicacion en el ordenador en la que ha exportado la pelicula y haga doble clicen ella
para verla en el reproductor de video.

Exportacion de una pelicula de QuickTime sin pérdidas con transparencia

En la seccién Video (Video) del cuadro de didlogo Movie Settings (Configuracién de pelicula),

seleccione Settings (Configuracion).

En el cuadro de didlogo Standard Video Compression Settings (Configuraciéon de compresién de
video estdndar), establezca Compression Type (Tipo de compresién) en Animation (Animacidn).

En la seccién Compressor (Compresor), establezca Depth (Profundidad) en Millions of Colors+
(Millones de colores+).

Compression Type: | Animation - ||
Motion Data Rate
Frame Rate: fps Data Rate: (&) Automatic

Restrict to kbits/sec
Key Frames: (@) Automatic

() Every frameg Optimized for:  Download

QA

Frame Reordering

Compressor Preview
Depth: | Millions of Colors w |
Quality
Lleast Lolw Meéium Hilgh Best

4. Hagaclicen OK (Aceptar).
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Configuracion de ajustes de video y sonido para peliculas de QuickTime

1. En el cuadro de didlogo Movie Settings (Configuracién de pelicula), seleccione si desea que la pelicula
incluya datos de Video (Video) y Sound (Sonido), y si el video debe optimizarse para el streaming de

Internet.
Video
Settings... Compression: Animation
Depth: Milions of Colors
Fitter. . Quality: Best
Size...
Allow Transcoding
Sound
Settings... Format: Uncompressed
Sample rate: 22.05 kHz
Sample size: 16
Channels: 1

Prepare for Intemet Streaming

| Fast Start ~ | Settings

Pardmetro Descripcién

Habilita la exportacién de datos de video al archivo de pelicula.

Settings (Configuracién): Abre el cuadro de didlogo Standard
Video Compression Settings (Configuracién de compresién de
video estandar).

Video (Video) Filter (Filtro): Abre el cuadro de didlogo Choose Video Filter
(Elegir filtro de video), en el que puede seleccionar distintos filtros
para aplicarlos a la exportacién de video.

Size (Tamafio): Abre el cuadro de didlogo Export Size Settings
(Exportar configuracién de tamafio). La configuracién de tamafio
se sobrescribe con la configuracién de escena de Harmony.

Habilita la exportacién de datos de sonido al archivo de pelicula.

Sound (Sonido) Settings (Configuracién): Abre el cuadro de didlogo Sound

Settings (Configuracién de sonido) (ver a continuacion).

Habilita la optimizacidn para el streaming en Internet.

Prepare for Internet Streaming Settings (Configuracién): Abre el cuadro de didlogo Hint Importer
(Preparar para streaming de Settings (Configuracién del importador de sugerencias) si estd
Internet) seleccionada la opcidn Hinted Streaming (Streaming por
sugerencias).

129



Capitulo 19: Exportacién de una pelicula

2. Enlaseccidén Video (Video), haga clic en Settings (Configuracidn).

Se abre el cuadro de didlogo Standard Video Compression Settings (Configuracién de compresién

de video estandar).

Compression Type: | H.264 v|
Motion Data Rate
Frame Rate: fps Data Rate: (®) Automatic

() Restrict to -kb'rtsfsec
Key Frames: (O) Automatic -

(®) Every 24 frames Optimized for:  Download
(@]

Frame Reordering

Compressor Preview
Quality

Least Low Medium Best

Encoding: (®) Best quality (Multipass)
() Faster encode (Single-pass)

? Cancel

3. En el mend Compression Type (Tipo de compresidn), seleccione un cddec. La disponibilidad de una
configuracidn de compresién determinada depende del tipo de compresién seleccionado. Por
ejemplo, cuando el tipo de compresidon de la animacion esta seleccionado, la opcidn Data Rate (Tasa

de datos) estd atenuada.

NOTA

Si desea renderizar una pelicula de QuickTime con compresidn y transparencia sin
pérdidas, puede utilizar el cédec de video de animacidn con la profundidad de color
establecida en Millions of Colours + (Millones de colores +).

4. En la seccién Motion (Movimiento), seleccione un valor de Frame Rate (Fotogramas por segundo) de

la lista.

Estd establecida de forma predeterminada para coincidir con los fotogramas por segundo (fps) del
proyecto de Harmony. Si selecciona un ndmero de fotogramas por segundo inferior, la reproduccién
de exportacién serd mas rapida que el proyecto real. Lo contrario también es cierto para un ndmero

de fotogramas por segundo superior.

5. Sidesea insertar fotogramas clave, seleccione la opcién Every (Cada) y establezca el ndmero por

fotograma.
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10.

11.

12.

Esta es la opcién recomendada por QuickTime. Para obtener mas informacién, consulte la
documentacion de QuickTime.

En la seccién Quality (Calidad), utilice el control deslizante para seleccionar una configuracién de
calidad. Recuerde que cuanto mejor es la calidad de la exportacién, mayor es el archivo.

Quality

Least Low Meélium Hilgh
=t -

En la seccién Data Rate (Tasa de datos), seleccione permitir que el programa seleccione
automaticamente la tasa de bits dptima, o bien introduzca una tasa restrictiva para ahorrar espacio y
permitir una descarga mas rdpida sacrificando calidad de exportacién.

En la misma seccién, en el menud Optimized For (Optimizado para), seleccione el método de
visualizacidn previsto para la exportacion.

Haga clic en OK (Aceptar).

Desde el cuadro de didlogo Movie Settings (Configuracién de pelicula), haga clicen Sound Settings
(Configuracion de sonido).

Se abre el cuadro de didlogo Sound Settings (Configuracién de sonido).

Compressor: | Mone V|
Rate: 22,050 kHz  [+]

Size: O Bbit (®) 16 bit

Use: ®Mono () Stereo

En el mend Compressor (Compresor), seleccione un tipo de compresién. La configuracion
predeterminada es None (Ninguno). Exporta el audio como si no hubiera realizado ninguna
compresién o conversion con pérdidas, conservando su fidelidad. Se pueden utilizar otros
compresores si necesita que la pista de audio de la pelicula se exporte en un formato especifico o si el
espacio en disco o la velocidad de descarga son criticos, pero pueden afectar de forma negativa a la
calidad de la pista de sonido de la pelicula.

En el menu Rate (Tasa), seleccione una tasa. Lo mejor es exportar el audio a una tasa que coincida
con la tasa de los archivos de sonido originales. Por ejemplo, si el archivo tiene una tasa de muestreo
de sonido de 48 kHz y elige una tasa de conversién de 22,05 kHz, el sonido se reproducird a la
misma velocidad, pero faltaran las frecuencias mds altas, haciendo que suene amortiguado. Como
referencia, la calidad de sonido esténdar es 44,1 kHz para peliculas y 48 kHz para DVD. Las tasas
mas bajas pueden afectar de forma negativa a la calidad de la pista de sonido de la pelicula, pero
pueden ser dtiles si el espacio en disco o la velocidad de descarga son criticos.
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13. Seleccione el tamafio de la codificacidon del audio en Size (Tamafio). También se conoce como
profundidad de bits. Determina la cantidad de precision utilizada para grabar cada longitud de onda
en la pista de sonido. El tamafio estandar es 16 bits. Si elige 8 bits, la cantidad de espacio en disco
que requiere la pista de sonido se reduce a la mitad, pero el sonido sonara amortiguado.

14. En Use (Utilizar), seleccione si desea utilizar el modo de canal Mono o Stereo (Estéreo). El sonido
estéreo tiene una pista de sonido independiente para los altavoces izquierdo y derecho, lo que
permite que el origen de cada sonido coincida de forma real con el origen de su accién
correspondiente. Si selecciona Mono, la pista de sonido puede utilizar menos espacio en disco, pero
los canales izquierdo y derecho se combinardn en una sola pista.

Configuracion de ajustes de video y sonido para Windows Media Video

1. En la seccién Video (Video), seleccione la calidad deseada para el video en Variable Bit Rate Quality
(Calidad de tasa de bits variable). Un ajuste mds alto garantizard una mejor calidad de imagen. Un
ajuste mas bajo creard un archivo video mds pequefio.

2. Utilizando la casilla de verificacién Sound (Sonido), seleccione si desea que su archivo de pelicula
tenga sonido o no.

3. Utilizando el menu desplegable Profile (Perfil), seleccione los ajustes de compresién preferidos para
la pista de sonido de la pelicula. Cada perfil tiene una combinacién de tasa de muestreo de sonido,
tamano de muestreo y modo de canal, que cubren las siguientes opciones:

o Tasa de muestreo: Las tasas de muestreo disponibles son 8000 Hz, 16 000 Hz, 22 050 Hz y
44 100 Hz. La configuracidn predeterminada es 22 050 Hz. Lo mejor es exportar el audio a
una tasa que coincida con la tasa de los archivos de sonido originales. Por ejemplo, si el
archivo tiene una tasa de muestreo de sonido de 48 000 Hz y elige una tasa de muestreo de
22 050 Hz, el sonido se reproducird a la misma velocidad, pero faltaran las frecuencias mas
altas, haciendo que suene amortiguado. Como referencia, la calidad de sonido estandar es
44 000 kHz para peliculas y 48 000 kHz para DVD. Las tasas mas bajas pueden afectar de
forma negativa a la calidad de la pista de sonido de la pelicula, pero pueden ser Utiles si el
espacio en disco o la velocidad de descarga son criticos.

« Tamano de la muestra: También se conoce como profundidad de bits. Determina la cantidad
de precisidn utilizada para grabar cada longitud de onda en |a pista de sonido. El tamafio
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estandar es 16 bits. Si elige 8 bits, la cantidad de espacio en disco que requiere la pista de
sonido se reduce a la mitad, pero el sonido sonard amortiguado.

NOTA

La exportacion en sonido de 8 bits solo es posible con QuickTime instalado.

« Modo de canal: El sonido estéreo tiene una pista de sonido independiente para los altavoces
izquierdo y derecho, lo que permite que el origen de cada sonido coincida de forma real con el
origen de su accidn correspondiente. Si selecciona Mono, la pista de sonido puede utilizar
menos espacio en disco, pero los canales izquierdo y derecho se combinardn en una sola pista.
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Glosario

3D estereoscépico

Capacidad de crear imagenes estéreo que, cuando se animan y se ven a través de gafas con
obturador activo 3D o mediante gafas con una lente roja y otra azul, se mostrardn como una
pelicula tridimensional.

canal alfa Canal de imagen que contiene informacién de transparencia. De partida, una imagen tiene
tres canales: rojo, verde y azul (RGB). El canal alfa es el cuarto canal (A). El mate, o
informacidn de transparencia, se almacena en este cuarto canal. Una imagen sin canal alfa
siempre es opaca.

animdtica Pelicula con sonido que se desarrolla a partir del storyboard. El panel de storyboard queda
expuesto durante el transcurso de la escenay, en ocasiones, los personajes se colocan en
una trayectoria para indicar movimiento. Los movimientos de cdmara también estdn
animados. La animdtica se utiliza para determinar el ritmo de un proyecto y proporciona una
buena visién general del proyecto antes de comenzar la produccién.

animacion Simulacién de movimiento creada mostrando una serie de imagenes o fotogramas.

anime Estilo de animacién conocido por su aspecto siniestro y oscuro, popular en Japén.

arco La accidén no suele producirse de forma directa, sino que mas bien se suele desplegar en lo

que los narradores denominan un arco. El propdsito de un arco de historia es mover un
personaje o situacién de un estado o escenario al siguiente.

proporcion

Relacidn entre las dimensiones de anchura y altura de una escena, fotograma o formato de
pelicula. La proporcidén en televisién es de 4:3 y la proporcién panoramica de 16:9.

alimentador de papel
automatico

Método automatizado de introducir dibujos en un escéner en el que hay varios dibujos
apilados en un alimentador de hojas. Cuando se activa el escdner, los dibujos se digitalizan
de forma consecutiva, sin ninguna otra intervencién del usuario.

deteccién automatica de
sincronizacién de labios

Asignacién automdtica de dibujos en un elemento a la carta de fonemas generada para un
sonido. Puede ahorrar tiempo al sincronizar los labios una pista de voz.

eje Linea imaginaria alrededor de la cual rota un objeto.
Para gréficos 2D, hay dos gjes: X (horizontal) e Y (vertical).
Para gréficos 3D, hay tres ejes: X (horizontal), Y (vertical) y Z (profundidad).
En animaciones que rotan constantemente, el elemento de eje especifica alrededor de qué eje
rota el objeto. Un nimero negativo provoca que una animacién rote en sentido contrario a las
agujas del reloj, mientras que un ndmero positivo hace que una animacién rote a la derecha.
fondo Parte de una escena que estd mds alejada hacia la parte posterior. El fondo es la ilustracidn, o

decoracidn, sobre la que se produce la animacidén.

curva Bézier

Método para definir lineas curvas inventado por el matematico francés Pierre Bézier. Una
curva Bézier es una curva matematica o paramétrica. Las curvas Bézier utilizan al menos tres
puntos para definir una curva.

mapa de bits

Imagen compuesta por pixeles con una Unica resolucién (tamafio). Si se amplia demasiado,
perderd definicién y comenzardn a aparecer pixeles individuales. A esto se le conoce como
pixelacién.
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Los archivos de imagen de mapa de bits se definen como una malla rectangular estandar de
pixeles individuales. Cada pixel individual contiene un valor que representa un color
especifico.

descomposicion

En animacién Cut-out, la descomposicion es la acciéon de descomponer un personaje en
trozos para crear una marioneta con articulaciones. Para descomponer un personaje, el
artista corta partes, como las manos y los brazos, del modelo del personaje y las pega en
capas independientes. A continuacidn, las articulaciones se fijan y se definen los pivotes.

En la animacidn tradicional, una descomposicién es una pose de animacién que
normalmente se encuentra entre dos poses clave. Las poses clave son las poses principales
de una animacién y las descomposiciones son poses secundarias que ayudan a describir el
movimiento y la curva de rotacién (normalmente denominada arco).

vibracién de camara

La vibracién de cdmara se produce en una escena cuando la cdmara se mueve ligeramente y
rdpidamente en varias direcciones. Este movimiento da la impresién de impacto, vibracién o,
por ejemplo, baches en la carretera.

cuadro de texto

Campo de texto que contiene informacién de didlogo, efectos, sonido o slugging en un
storyboard.

celda

En la animacidn tradicional, una celda (también denominada celuloide) es una hoja
transparente en la que la animacidn se tinta y se pinta antes de enviarla a la cdmara. El
trazado de la imagen se dibuja en |la parte delantera de la celda y, a continuacidn, se colorea
por la parte trasera.

disefio del personaje

Cada personaje de una pelicula animada se dibuja desde varios dngulos en formato de estilo
pdéster denominado hoja de modelo, que sirve como referencia para los animadores.

aberracién cromatica

En dptica, una aberracién cromatica (CA), acromatismo o distorsién cromdtica, es un tipo de
distorsién en el que una lente no puede enfocar todos los colores en el mismo punto de
convergencia.

clean up

Una vez que los bocetos se han evaluado y aprobado, se quita todo el ruido de laimagen
(Iineas sobrantes, notas, etc.) para crear dibujos finales que se pueden tintar, pintar y filmar.
El proceso de clean up hace referencia al trazado de una linea limpia sobre un boceto para
conseguir la versidn final o a la eliminacidn de la suciedad y las lineas adicionales que han
quedado tras el proceso de digitalizacidn.

CMYK

Acrénimo en inglés de cian, magenta, amarillo y negro. Estos colores forman el modelo
estandar utilizado en un proceso denominado impresidn offset.

carta de color

Una carta de color es una tarjeta que contiene un color sélido con el mismo tamafio que la
cdmara. La carta de color rellena el fondo con un color sélido cuando no se haincluido
ninguna imagen de fondo.

modelo de color

Disefio de color oficial que se debe utilizar para pintar la animacién. Un modelo es el disefio
de personaje, prop o ubicacién definitivo que cada artista debe seguir para la produccidén.

circulo cromdtico

Visualizacién del espectro de colores en forma de circulo.

composicién

La composicidn es la accidn de incorporar todos los elementos de una escena para crear el
resultado final antes del renderizado. Por ejemplo, el artista de la composicién importard
todas las secuencias, el fondo, las superposiciones y las subcapas de la animacién en la
escenay los colocard correctamente. A continuacién, el artista definird el encuadre de cdmara
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y lo animard en caso necesario. Por Ultimo, el animador creard todos los efectos generados
por ordenador para el proyecto.

fundido encadenado

Efecto utilizado para fundir dos escenas, una dentro de la otra.

corte

Transicién directa entre dos escenas. Cuando se utiliza un corte, no se insertan efectos de
transicidn para pasar de una escena a la siguiente. La primera escena termina y la segunda
comienza inmediatamente.

animacién Cut-out

El proceso conocido como animacién Cut-out es la accién de animar personajes compuestos
por varias piezas moviéndolos de fotograma en fotograma. La animacién Cut-out se puede
generar por ordenador o realizarse del modo tradicional utilizando papel.

ciclo Grupo de imdgenes que forman juntas una accién, como caminar. Un ciclo es una accién
repetida como un bucle durante un periodo de tiempo. Puede ser una serie de dibujos o
fotogramas clave animados.

didlogo Texto hablado por un personaje en una pelicula o animacién.

carta de rodaje

La utilizan los animadores, directores y otros miembros del equipo para trazar la secuenciay
el tiempo de las imagenes, el didlogo, los efectos de sonido, las pistas de sonido y los
movimientos de cdmara. Conocida también como carta de exposicidn.

usar carta de rodaje

Asignar un dibujo determinado a un rango de fotogramas.

paso con doble bote

En los fotogramas clave y las posiciones de paso de un paso con doble bote, el cuerpo es
menor que una linea de referencia dibujada en posicidn vertical. Durante los intercalados, el
cuerpo estd situado sobre esta linea, ofreciendo asi un aspecto de rebote.

DPI

Siglas en inglés para puntos por pulgada, que representa la medida estdndar de resolucién
para impresoras computerizadas. En ocasiones se aplica a pantallas, en cuyo caso es mas
exacto denominarlo pixeles por pulgada. En cualquier caso, el punto es el elemento
diferenciado mds pequefio que forma la imagen.

aceleracién

En animacidn, la velocidad es la aceleracién y la desaceleracién de un movimiento. Puede ser
un movimiento creado mediante una curva de funcién o una serie de dibujos animados.
Otros términos comunes para aceleracién-gradual y desaceleracién-gradual son aceleracién
y desaceleracidn.

aceleracién-gradual

Aceleracion gradual en la accién. Conocida también como aceleracidn.

desaceleracién-gradual

Desaceleracion gradual en la accién. Conocida también como desaceleracidn.

plano de situacién

Escena en la cual el espectador puede ver toda el drea en la que se estd produciendo una
secuencia. Por ejemplo, si un nifio esta jugando en el patio delantero de su casa, el plano de
situacidn serfa una escena en la que el visor puede ver la casa, el patio, parte de la calley los
edificios situados alrededor del punto de accidn central. Esto ayuda al espectador a entender
la ubicacidn de la historia y la orientacién de la escena.

exposicion

En animacidn, una exposicidn es el nimero de celdas en las que un dibujo aparece en la
escena. Para que un dibujo parezca mas grande, la exposicién se debe ampliar durante un
nudmero de celdas mayor.

carta de exposicion

Hoja con varias columnas verticales y fotogramas horizontales que se utiliza para indicar el
tiempo de una escena. Cada columna representa una capa de escena. Los ndmeros de
dibujos de cada columna se indican y se repiten alo largo de la cantidad de fotogramas
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determinada en la que deben aparecer.

La carta de exposicidn la utilizan los animadores, directores y otros miembros del equipo para
trazar la secuencia y el tiempo de las imagenes, el didlogo, los efectos de sonido, las pistas
de sonido y los movimientos de camara. Conocida también como carta de rodaje.

fundido de
entrada/fundido de salida

El fundido de entrada o fundido de salida es un efecto de transicidn utilizado para abrir o
cerrar una secuencia. Un fundido de entrada se produce cuando la primera escena aparece
progresivamente, desde una transparencia total a su opacidad total. Un fundido de salida se
produce cuando la escena desaparece progresivamente, desde la opacidad total ala
transparencia total.

aceleracién de entrada

Aceleracion drdstica al principio de la accidn.

aceleracién de salida

Aceleracion dréstica al final de la accidn.

campo

Unidad de medida utilizada para calcular el movimiento, el registro y la posicién de la cdmara.
Una escena de animacidén estdndar tendrd entre 6 y 12 campos.

hoja de campos

Guia que contiene todas las unidades de campo que los artistas de animacién y layout
utilizan para determinar un tamafo de escena o movimiento de cdmara.

film-1.33 Resolucién idénea para el formato de pelicula panordmico que se ajusta a la proporcidn
estdndar de 4:3 pixeles.

film-1.66 Resolucidn idénea para el formato de pelicula panordmico que se ajusta a la proporcién de
16:9 pixeles. (Los pixeles son mds anchos que altos).

flipping En la animacidn tradicional, flipping es la accién de pasar por los dibujos de una secuencia

de animaciéon muy rdpidamente con el fin de ver la animacién en movimiento. Flipping
también puede ser la accién de crear una transformacién en espejo de un objeto.

animacidn secundaria

Movimiento secundario provocado por la accidn principal. Por ejemplo, un personaje que
corre y lleva puesta una capa. La accién principal es el cuerpo que corre. Esto provocara que
la capa siga el movimiento, aunque no se moverd al mismo tiempo, sino que reaccionard
varios fotogramas después y seguird la curva de movimiento principal.

cinemadtica directa

La cinemética directa es una funcidn utilizada para animar principalmente personajes 3D y
marionetas Cut-out con jerarquia. Se utiliza para animar una marioneta a partir de una de sus
partes padres, como un hombro, y hacer que el resto del brazo se mueva con ella como un
todo.

fotograma

Un fotograma de animacidn es una imagen fotografica Unica en una pelicula. En la animacién
tradicional, el estdndar norteamericano contiene generalmente 24 fotogramas por segundo,
mientras que el estdandar europeo es de 25.

fotogramas por segundo

Representan la velocidad a la que se reproducen los fotogramas. Se calculan por lo general
en fotogramas por segundo. Por ejemplo, una escena se podria reproducir a 12, 24, 25, 30 o
60 fotogramas por segundo o a cualquier otro néimero.

Es la medida de la frecuencia (tasa) a la que un dispositivo de imagen produce imdgenes
consecutivas Unicas, denominadas fotogramas. El término se aplica por igual a los graficos
por ordenador, videocdmaras, cdmaras de pelicula y sistemas de captura de movimiento.

La tasa de fotogramas se suele expresar principalmente en fotogramas por segundo (fps) y
en monitores de barrido progresivo en hercios (Hz).
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funcién Movimiento, trayectoria o ruta generados por ordenador al que se pueden conectar
pardmetros de elementos, otras trayectorias y efectos. La funcién se puede controlar
agregando fotogramas clave y puntos de control en la curva de funcién.

gama Rango de colores que puede representar un dispositivo determinado.

HDTV Acrénimo en inglés de televisidn de alta definicién que ofrece una imagen de mayor calidad
que la televisidn estdndar, ya que dispone de un nimero de lineas de resolucidon superior.
Para sacar partido de la calidad superior y utilizar plenamente la configuracién de resolucidn,
el dispositivo de salida debe ser compatible con la tecnologia HDTV.

hold Fotograma en la animacidn en el cual el personaje mantiene su posicién sin moverse. Se
puede crear un hold entre dos fotogramas clave cualesquiera.

HSV Siglas en inglés para matiz, saturacién y valor. Método para definir los colores en cuanto a
matiz (tinte), saturacién (sombra) y valor (tono o luminancia).

intercalado Dibujos que existen entre las poses clave. Se dibujan para crear transiciones fluidas entre
poses.

ink and paint El proceso ink and paint es la accién de pintar las zonas vacias y colorear las lineas en los

dibujos de animacién finales siguiendo un modelo de color.

interpolacién

Movimiento generado por ordenador creado entre dos fotogramas clave. Se puede crear
interpolacidn, o no, entre los fotogramas clave.

cinemdtica inversa (IK)

Funcidn utilizada principalmente para animar personajes 3D y marionetas Cut-out con
jerarquia. La cinemdtica inversa animara una marioneta desde una de las extremidades, como
una mano, y permitird que el resto del cuerpo la siga con naturalidad.

corte de salto

Corte brusco entre dos escenas. Normalmente, un corte de salto no es visualmente
agradable. Normalmente lo provoca el final de una escenay el comienzo de otra, con una
imagen parecida. La falta de diferencia provoca que el ojo vea un pequefo salto entre las dos
escenas.

pose clave

Posiciones importantes en la accidn que definen los puntos inicial y final de cualquier
transicidn suave. Las claves, o poses clave, son los dibujos principales de una secuencia de
animacién que describen el movimiento. Por ejemplo, si se agita un brazo, las claves
corresponderan al brazo de una extremidad del movimiento de onday a la otra extremidad. Al
realizar un flipping de dichos dibujos, el animador puede ver el esqueleto del movimiento sin
tener todos los dibujos.

atajos de teclado

Una o varias teclas del teclado que, al usarlas, provocan que se realice una operacién.

fotograma clave

Posiciones importantes en la accidn que definen los puntos inicial y final de cualquier accidén.
Un fotograma clave es una posicién generada por ordenador en un momento especifico
(fotograma) y en una trayectoria determinada.

capa En animacién, una capa es una columna, nivel o personaje individual. Las capas de una
escena estdn superpuestas para formar la imagen final.
layout Paso de comunicacién entre el storyboard y la animacidn. Es la accién de poner el storyboard

en el modelo. Es decir, el personaje se dibuja siguiendo el disefo del paquete de modelo, de
modo que el animador puede comenzar a trabajar.

El artista de layout dibuja el fondo y crea la cdmara y la guia de campo, haciendo coincidir la
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escena y el movimiento de la cdmara. Por Ultimo, el animador dibuja en el modelo las poses
de accidn principales.

layouty pose

Accién que consiste en poner el storyboard en el modelo (a la escala adecuada) para que el

animador comience a trabajar.

artista de layout

Artista que dibuja el fondo y crea la cdmara y la guia de campo, haciendo coincidir la escenay
el movimiento de la cdmara. Dibujard en el modelo las poses de accidn principales.

planificacién de layout

Dibujo de las funciones principales de la escena que se utiliza como referencia al planificar la
animacién y ejecutar sus etapas iniciales.

proceso de layout

Paso de comunicacidn entre el storyboard y la animacién.

libreria Zona de almacenamiento que contiene plantillas y recursos que se pueden reutilizar en un
proyecto o escena.
mesa de luz Dispositivo que permite ver otras capas en transparencia mientras trabaja en una capa

determinada.

linea de accién

Direccidn que seguira la accién. Conocida también como linea de accidn.

sincronizacién de labios

Proceso que consiste en sincronizar la boca de un personaje con sonidos en la pista de
sonido del didlogo. La boca se ajusta fotograma a fotograma para hacer coincidir el sonido
del didlogo y aparentar que el personaje estd hablando. La sincronizacién de labios se puede
utilizar para cualquier secuencia de sonido y no solo para el habla. Por ejemplo, puede hacer
que un pdjaro pie o que un lobo adlle ala luna.

baja resolucién

Formato idéneo para videos destinados a la web, donde el tamafio y la descarga répida del
archivo de video tienen prioridad respecto a la calidad. Una imagen de baja resolucién es
aquella que no contiene detalles precisos.

deteccién manual de
sincronizacién de labios

Intercambio manual de dibujos de posicién de la boca para que coincidan con una pista de
voz. Para este proceso, se utilizan tanto la depuracién de sonido (escuchar una onda de
sonido descompuesta fotograma a fotograma) como las sustituciones de dibujos.

paleta maestra

Grupo de colores atribuidos a un personaje o prop. La paleta se utiliza durante toda la
produccién para mantener la coherencia en el aspecto y para garantizar que se utilicen los
mismos colores durante la produccién. Conocida también como paleta.

modelo/modelo de color

Disefio de personaje, prop o ubicacién definitivo que cada artista debe seguir para una
produccién. Un modelo de color es el disefio de color oficial que se debe utilizar para pintar
la animacién.

morphing

Funcidn que permite crear dibujos generados por ordenador entre un dibujo de origen y otro
de destino. La animacidn creada con la funcién de morphing se puede reutilizar en distintos
proyectos.

fotograma clave de
movimiento

Fotograma clave con interpolacién generada por ordenador.

carta de fonemas

Carta basada en los ocho fonemas de la animacién (A, B, C, D, E, F, G y X, que se utiliza para

representar el silencio) utilizados para la sincronizacién de labios.

multiplano

Efecto de pasar por diversos niveles de dibujos para crear una sensacién de profundidad en
un plano. Un multiplano es una escena en la que las capas estdn colocadas a distintas
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distancias de la camara, de modo que, cuando la cdmara se mueve, se produce una ilusién de
profundidad. Con un multiplano, toda la perspectiva y la escala se calculan automaticamente.

NTSC

Sistema de difusidn televisiva analdgico estandar utilizado en Norteamérica. NTSC se cifie a
los estandares norteamericanos respecto al modo en que los pixeles rectangulares se
muestran para las pantallas de ordenador y de televisidn.

desplazamiento pequeio

Pequefio empujén (izquierda, derecha, arriba, abajo, hacia delante o hacia atras) realizado
con las teclas de flecha del teclado en un elemento seleccionado. El desplazamiento pequeno
se utiliza para mover una seleccién de manera muy ligera y precisa.

papel cebolla

Funcién que permite ver los dibujos anterior y siguiente de una secuencia.

capa superior

Parte del entorno de una escena, como una silla o un arbusto, que se coloca delante de la
animacién principal.

PAL

Resolucién que funciona mejor con el formato europeo para pantallas de televisién y de
ordenador, ya que los pixeles rectangulares se muestran con una orientacién distinta.

paleta/paleta maestra

Una paleta o paleta maestra es un grupo de colores atribuidos a un personaje o prop. La
paleta se utiliza durante todo el proyecto para mantener la coherencia en el aspecto y para
evitar cambios de color durante la animacién. También se le denomina paleta maestra.

estilo de paleta

Un estilo de paleta es una segunda versién de una paleta existente con un ligero cambio en el
tinte y el valor. Un estilo de paleta se puede utilizar para crear la versién nocturna de una
paleta. También se le puede denominar paleta de clonado.

panear

Mover la cdmara atravesando la escena en cualquier direccidn.

panel

En un storyboard, un panel es un fotograma en un plano. Un plano puede estar compuesto
por uno o varios paneles.

animacion sin
papel/tradigital

El proceso de animacidn sin papel es la accidn de animar digitalmente. El principal proceso
de animacidn sin papel es dibujar la animacién, fotograma a fotograma, directamente en el
software.

posicién de paso

Al dibujar una secuencia en la que un personaje camina, la posicién de paso es el punto en el
que una pierna pasa a la otra.

linea de accién

Direccidn que seguira la accién. Conocida también como linea de accidn.

peg

En la animacidn tradicional, es una herramienta utilizada para garantizar el registro preciso de
la accién a medida que se mueven las capas de celdas. En la animacién digital, en la que se
realiza un rigging de marionetas mds avanzado, se pueden usar capas de pegs. Las capas de
pegs son capas de trayectoria que no contienen dibujos. Son rutas de movimiento que puede
usar para agregar articulaciones de ruta. Para las dltimas, también puede utilizar una
herramienta de cinemdtica inversa.

fonema

Unidad de sonido de un idioma.

pivote

Punto alrededor del cual un peg o dibujo rota.

pixel

Elemento mas pequefio de una imagen mostrado en un monitor o pantalla de televisién.

El pixel, abreviatura en inglés de elemento de imagen, es un punto Unico en una imagen
gréfica. Es una pequefia muestra de una imagen, un punto, un cuadrado o una seccién muy
pequefia compuesta de filtrado suavizado. Si acerca el zoom lo suficiente en una imagen
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digital, verd los pixeles, que parecen pequefios cuadrados de distintos colores e intensidad.

animacién pose a pose

El proceso de animacidn pose a pose es la accién que consiste en crear todas las poses de
accidn principales, denominadas poses clave, y después colocar las poses secundarias entre
las claves. Las poses secundarias se denominan descomposiciones. Por Ultimo, el animador
rellena los huecos con los dibujos intercalados para lograr una animacién fluida.

renderizado

Paso final de la animacidn por ordenador. Durante el renderizado, el ordenador toma cada
pixel que aparece en la pantalla y procesa todos los componentes. Ademds, agrega
desenfoque de movimiento antes de que produzca una imagen final. Es el proceso de
calcular las imdgenes finales después del proceso de composicién.

resolucién Tamano de una escena, calculado por lo general en pixeles. Por ejemplo, la resolucién NTSC
es de 720 x 480. La resolucién debe coincidir con la salida final: HDTV, film-1.33, film-1.66,
NTSC, PAL, baja.

RGB Siglas en inglés para rojo, verde y azul. Método que permite definir el color especificando las
cantidades de estos tres componentes del color.

rigging Proceso de conectar las distintas partes de una marioneta Cut-out.

mesa de disco

Equivalente al disco/mesa de animacidn, es un dispositivo que permite rotar el espacio de
trabajo para mayor comodidad mientras se dibuja.

rotoscopia Técnica de animacidn en la que los animadores trazan un movimiento de pelicula de accidn
en vivo, fotograma a fotograma, para usarlo en peliculas animadas. Es el acto de esbozar
sobre material de accién en vivo para crear una secuencia animada.

bocetos Es un nombre comun en una pelicula de animacidn para un dibujo que se utiliza como

referencia, pero no forma parte de la imagen final. Un layout es un boceto.

Es el esbozo del esqueleto de una animacién o disefio. Los bocetos consisten principalmente
en lineas y formas esbozadas, pero también pueden contener detalles de disefo.

Zona segura

Zona central del fotograma de una escena que no quedard recortada por el fotograma de TV.
Como un fotograma de TV corta un margen del tamano del fotograma original, al mantener
una zona segura se garantiza que la accidn principal de la escena siga siendo claramente
visible una vez que la pelicula se proyecte en televisidn.

escena Plano en una pelicula o programa. Una secuencia estd compuesta por varias escenas. Una
escena cambia a otra mediante un corte simple o por transicién.

guion Texto original que contiene la informacién de toda la pelicula o el programa. En animacidn, el
guion contiene todas las descripciones de la ubicacidn, el didlogo, el tiempo, etc. Un
proyecto comienza con un guion.

secuencia Serie de escenas o planos que forman una parte distinta de |a historia o pelicula,
normalmente conectada por la unién de la ubicacién o el tiempo.

plano Escena en una pelicula o programa. Una secuencia estd compuesta por varios planos. Un

plano cambia a otro mediante un corte simple o por transicién.

aceleracién

Aceleracién gradual en la accién. Conocida también como aceleracién-gradual.

desaceleracion

Desaceleracion gradual en la accién. Conocida también como desaceleracién-gradual.

slugging

Indicacidn de los tiempos de inicio y detencién de un didlogo y las acciones relevantes.
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depuracién de sonido

Proceso que permite escuchar el sonido en tiempo real, mientras mueve el cabezal de
reproduccidn hacia delante o hacia atrds. Es muy Util para realizar el ajuste preciso de una
sincronizacién de labios.

fotograma clave de Stop-
motion

Fotograma clave sin interpolacién generada por ordenador.

storyboard

Plan visual de todas las escenas y planos de una animaciodn. El storyboard indica lo que
sucederd, cuando lo hard y cdmo se distribuyen los objetos en una escena.

animacién directa

Técnica en la cual se dibuja por orden una secuencia completa desde la primera posicién
hasta la Ultima. Esta metodologia requiere muy poca planificacién. El lugar en el que el
personaje terminay cdmo llega hasta alli pueden ser una sorpresa tanto para el publico como
para el animador. Este enfoque es esponténeo y creativo, pero puede generar resultados
imprecisos.

lineas vectoriales

Lineas vectoriales invisibles que forman las zonas de dibujo. Se pueden ajustar mediante

transparentes controladores de curvas Bézier.

simbolo Un icono combina animacidn, ilustracién o capas en un Unico objeto que puede controlar en
una capa. También puede crear iconos de cada parte del cuerpo en marionetas Cut-out.
En un icono puede colocar lo que desee. Puede utilizar simbolos para animar una marioneta
o crear animaciones reutilizables, como un parpadeo.

tableta/ldpiz Dispositivo utilizado junto con un ratén, o en lugar del mismo, para mover el puntero (en
ocasiones denominado cursor) por la pantalla del ordenador.

plantilla Recurso almacenado en la libreria que se puede reutilizar en cualquier proyecto. Una plantilla

puede ser un dibujo, una serie de fotogramas clave, un archivo de sonido, un panel, un
personaje Cut-out, un efecto, una trayectoria, una animacién o cualquier otra cosa que se
utilice en la animacidn.

imagen miniatura

Imagen muy pequena utilizada como una referencia o indicador.

cédigo de tiempo

Informacién de tiempo impresa en un clip de pelicula para indicar la escena, hora, minuto y
segundo que se muestran actualmente en pantalla.

linea de tiempo

Representacién horizontal de los elementos, el tiempo y los fotogramas clave de una escena.

trazar y pintar

Una vez que los bocetos de las animaciones se han limpiado y se ha realizado una prueba de
linea o de ldpiz final, cada dibujo se traza y se pinta para la animacidn final. En el mundo
digital actual, esto se puede realizar de maneras distintas a los métodos de celuloide o
acetato tradicionales.

desglose de pista de
audio

Desglose de una pista de pelicula animada en sonidos individuales para generar la posicién
fotograma a fotograma precisa de cada sonido.

animacion tradicional

Tipo de proceso de animaciéon mediante el cual todas las secuencias de animacidn se dibujan
a mano en papel antes de digitalizarlos o tintarlos en celdas.

trayectoria

Ruta o trayectoria generada por ordenador que pueden seguir los elementos. La trayectoria se
puede controlar mediante puntos de control, fotogramas clave y velocidad.

transicion

Efecto colocado entre dos escenas cuando se pasa de una a otra. Efectos de transicién
comunes son el fundido encadenado vy el barrido.
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capa de fondo

En animacidn, una capa de fondo es una parte especifica de la decoracién colocada detrds de
la animacidn principal.

vector

Una imagen basada en vectores estd compuesta por puntos y curvas Bézier. El ordenador lee
los puntos y traza los segmentos, vinculandolos para reproducir la forma de imagen. Una
imagen vectorial no contiene tamafio fijo ni resolucidén. El gréfico se puede ampliary
distorsionar seguin se desee y el sistema volverd a calcular los segmentos y reconstruird las
formas. Las imagenes vectoriales se trasladan y se muestran en pixeles una vez que el célculo
se ha realizado.

velocidad

En animacidn, la velocidad es la aceleracién o la desaceleracién de un movimiento. Se puede
alcanzar mediante una curva de funcién o una serie de dibujos animados. Otros términos
comunes para aceleracién-gradual y desaceleracién-gradual son aceleracién y
desaceleracidn.

ciclo de andar

Animacidn que representa a un personaje mientras camina en su posicion. La ilusién de
movimiento se crea utilizando paneos de fondo. A fin de evitar animar a un personaje que
camine unay otra vez en cada episodio de una serie, es habitual preparar ciclos de andar para
cada personaje en una produccién, de modo que se pueden reutilizar segin sea necesario.

zZona

Area que se puede pintar con color.
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